


 

作者简介 
 
罗昭锋，自 2004 年起开始在校

内推广文献管理软件 Endnote，
之后每学期均举办多次培训讲

座，参加培训的学员累计已超

过 2000 人次。2006 年编写了

《Endnote X 中文用户手册（试

用版）》，在网上广泛传播。2007
年 9 月以来，在读者的支持鼓

励下，以及五位热心朋友的直

接参与下，编写了本书。 
作者供职于中国科学技术

大学生命科学实验中心，主管

蛋白质功能及药物研究平台。

主要的仪器有 BIACORE3000、
等温滴定微量热仪（ITC）、 液
相色谱系统（分析和制备型）、

圆二色谱仪、毛细管电泳、多

肽 N 端测序仪、高通量药物筛

选系统、生物发光光度计、动

态光散射、紫外光谱、荧光光

谱及红外光谱。作者的主要工

作是为国内生命科学及相关科

学研究提供技术支持和服务，

欢迎校内外各单位前来交流、

测试和合作。有关详细信息，

请 参 考 网 站 资 料

http://biotech.ustc.edu.cn。 
 
本手册的下载地址： 
http://biotech.ustc.edu.cn/

upimg/endnote/infomanual

.pdf 
 
 
 
 

封面设计：朱巧云 
zhuqiao_yun@163.com 



 

内 容 概 览 

 
 

 

Endnote 

 海量文献信息的管理 

 全文管理 

 笔记管理 

 自动编排论文或书籍的参考文献 

 利用杂志全文模版撰写论文 

 统计与分析 

 

RefViz 

 海量文献信息分析 

 文献自动分类 

 给出文献间相互联系 

 发现研究前沿和热点 

 1 小时把握 10000 篇文献的主旨 

 

Quosa 

 PDF 全文信息分析软件 

 自动下载 PDF 全文 

 自动追踪最新文献 

  



 

绪   言 

决定编写此书是缘于几年来的 Endnote 推广工作以及去年编写的一本小册子。去年国庆

期间编写了《Endnote X 中文使用手册（试用版）》，10 月 8 日发布在校园网上，当初希望通

过校内读者的反馈进行修订之后再向外发布，后来由于种种原因，未能及时进行修改，而这

本小册子也被转到了国内多个论坛上，逐渐开始在网上传播开来。 

在过去的这一年中，收到大量的信件，有提出建议的、有请教问题的，还有很多就是为

了表示致谢和鼓励的。记得有位老师说，他们单位给每位老师印发了一本。这些信件给了我

莫大的鼓励和安慰，非常感谢各位网友的支持。没有你们的支持、鼓励和期待，我很难下舍

下手头的实验来编写此书。 

信息是一个人得以生存的基础。创新实际上是我们种到头脑中的种子开花之后结出的

果实。没有输入信息的头脑，好比没有洒下种子的土地。不管土地有多肥沃，也结不出丰

硕的果实。我曾考虑过一个问题，为什么现在的孩子比多年前的孩子要聪明；同时代而言，

城市里同龄的孩子要比农村里的孩子聪明。我觉得关键就是他们接触的信息量不同。俗话说，

种瓜得瓜，种豆得豆。要想我们的大脑结出丰硕的果实，就要种下大量而且饱满的种子。

对科研工作者而言，这些种子就是文献信息。我们播种的信息决定了结出果实的质量。任

何人的创新都是在前人的基础之上。科学工作者如果不能掌握前人已有的工作基础，所谓的

“创造”不过是闭门造车而已。中国有过太多这样鲜活的实例。全面掌握前人的工作，就如

同站到了巨人的肩膀上。 

对于一个科研工作者来说，关于文献信息我觉得要掌握三方面的能力：一是文献信息的

获取能力；二是文献信息管理能力；三是文献信息分析和利用的能力。 

文献信息的获取能力相对来说比较容易，大致说来有以下一些途径：（1）综合性数据库

（Web of Science， Pubmed 等），（2）专题数据库（Gene Bank，蛋白质结构数据库， 分子

相互作用数据库， 化学反应数据库等），（3）专利数据库，（4）会议论文数据库，（5）学位

论文数据库，（6）综合搜索引擎，（7）咨询和交流，（8）公司的网站及产品技术手册。 

文献信息管理能力在网络时代才变得复杂。多年前，我们只能获得很少量的信息，一般

通过记录本或者记录卡就可以进行管理。如今每个人都可以获得大量的信息，管理就显得重

要起来。本书中推荐大家利用 Endnote 进行文献管理。它可以帮助你进行全文管理和笔记管



 

理等，便于大家进行检索和分析。提供一些杂志的全文模板，同时可以自动帮你编排参考文

献信息。 

文献信息分析是在文献多到无法阅读的时候才显得重要的。如今随便用一个关键词就可

以找到成千上万篇文献，我们不可能把这些文献一一阅读一遍，因此就要求我们能够从这些

文献中找出最相关的信息来。过去我们习惯不断限制检索条件，将文献数限制在有能力阅读

的范围内。如今通过本书，我们为你提供了一套更好的解决方案，那就是利用文献信息分析

软件，它们能够帮你在短时间内把握大量文献的主旨信息。本书介绍的 RefViz 和 Quosa 就

属于这类软件。 

作者真诚希望本书能帮你提高驾驭文献信息的能力，让你真正站到巨人的肩膀上。为自

己的大脑种下优质的种子。 

如果你想在 Nature 或者 Science 上发表论文，首先就得学习 Nature 或者 Science 上别人

所做的工作。如果我们每天只阅读那些下三滥的论文，决不会想出奇妙的点子，做出惊人的

创新来的。 

要创造就要给大脑输入有用的信息。面对浩瀚的信息，如何快速找到最相关的信息，

如何发现这些信息之间的相互关联，正是本书想为你解决的问题。 

本书介绍的三大软件，Endnote 将教你如何管理数以万计的文献，如何管理全文，如何

管理阅读笔记，以及如何利用 Endnote 来撰写论文，编排参考文献等。 

RefViz 是一个文本信息分析软件，可以根据文献标题和摘要信息进行文献分类，并指

出文献间相互关系。熟练掌握这个软件，你将会轻松驾驭海量的文献信息，快速获取最重要

的信息，为你提供不竭的创新思路。 

Quosa 是一款全文分析软件，可以自动下载全文，并对全文进行分析，还可以提取已下

载的 pdf 中的引文信息。 

综合利用以上三个软件，基本可以满足你对文献分析与管理的需求。 

这本书不同于去年编写的手册。首先从内容上要丰富很多，去年的手册仅包括本书中第

一部分的内容。此书中增加了 Endnote 高级功能部分和常见问题解答。Refviz 和 Quosa 两

个软件也是新增的内容。从编写的目的来看也是大不相同，去年只是满足于让大家学会使用

Endnote，此书更希望为科研工作者的文献管理与分析工作提供一套解决方案。另外，此书



 

还是集体智慧和经验的总结，避免了个人思路的局限，使其更具参考价值。 

参与编写的共有六人，分别是：文献管理版的版主，远在美国求学的王研，参考我去年

的手册，编写了本书的第一部分；南京农业大学博士研究生韩敏义编写了 Endnote 高级功能

部分的第四至第七章，其中很多是我所不熟悉的，使我获益良多；夏春智（山东大学博士研

究生）、田二坡（汕头大学医学院研究生）和陈飞（重庆大学）三位编写了常见问题解答部

分，他们分别搜集了我们的论坛、Endnote 网站、以及 QQ 群众常见的问题，并一一给出了

解决方案，具有重要的参考价值。一般新手碰到的常见问题都给予了很好的解决方案。我参

与编写了高级功能部分中的主题列表和 Endnote Web 部分，以及 RefViz 和 Quosa 两个软件

的介绍。RefViz 和 Quosa 这两个软件目前国内应用的较少，很难找到有价值的参考资料。

因此只好翻阅原版说明书，为此打印了 RefViz 说明书的全部内容，阅读过不止一遍，仍有

很多地方不是很清楚。这个软件其实并不难学，难在灵活应用上，难在通过软件获得自己想

要的信息。这部分内容书中只能通过举例来加以说明，读者只有通过不断练习和揣摩才能熟

练掌握。Quosa 是最近才开始学习的软件，尽管很不熟悉，但很多功能很重要也很实用，一

并予以介绍，希望对大家入门起到一点指导作用。 

去写这些不太熟悉的内容是需要勇气的，总担心有误人子弟之嫌。好在此书读者都是高

级知识分子，能够识别出一些显而易见的错误，才让我免了一份顾虑。在此真诚地恳请各位

读者如果发现书中有什么错误请一一指出，我们会将发现的错误更正信息发布在论坛上，并

且如果有机会在进行改进的话一一予以更正。反馈的方式可以给我发送 email

（smilesun@ustc.edu），或者将相关内容发布在论坛上（http://biotech.ustc.edu.cn/forum 文献

管理版）。如果你在文献管理和信息分析方面有好的经验，也希望你能发布到我们的论坛上，

让更多人分享你的经验。 

关于本书的版权，如同我去年编写的手册，只要不用于商业目的，欢迎任何形式的传播

和转载，希望尽量保持原始文件的真实性。 

在本书编写过程中，我们参考了一些网络资源，如在编写常见问题解答部分，参考了中

科院植物研究所综合办公室周凌娟编写的《Endnote 使用 FAQ》。在我最初学习 RefViz 时，

丁香园中一位网友写的《文献分析软件 RefViz 点点通》给我了一些帮助。还有些未能一一

指出的，在此一并向原作者致敬。 

非常感谢各位网友给予我的鼓励，你们让我认识到这项工作的价值，让我愿意继续为此



 

而努力。感谢参与编写本书的各位“战友”，尽管我们彼此素不相识，但几位战友都是经验

丰富的热心人士，在 QQ 群以及论坛上，为各位新手排忧解难。他们无私的奉献，为我们搭

建了一个交流的平台。感谢你们无私的付出，没有你们的付出，就不会有本书的面世。 

我还要特别感谢我的妻子，她对我的倾力支持，以及她对我生活的悉心照顾，才使我能

忙里偷闲来撰写这些文字。 

 

罗昭锋 

于中国科学技术大学 

2007-11-25 

 

 

   



 

导    读 
 

本书不是研究文献管理与信息分析的理论著作，而是通过介绍三个软件，希望能为科研

工作者的信息管理与信息分析工作提供一套解决方案。 

本书介绍的三个软件分别是 Endnote，Refviz 和 Quosa。Endnote 是目前最受欢迎的文

献管理软件。Refviz 是 Thomson 公司和 Ominiviz 公司合作开发的针对文献信息挖掘的一款

软件，可以对大量的文献信息进行分析和归类，并以可视化的图形界面将分析结果直观地显

示出来，能帮助我们快速掌握一系列文献的主题内容，并且可以发现文献间的相互联系。是

处理海量文献信息的得力工具；另外，还可以与 Endnote 实现无缝对接，对 Endnote 数据库

的文献进行分析或将分析结果输出到 Endnote。Quosa 是一款全文文献分析软件，可以自动

从网上下载 PDF 全文，并对全文进行分析，找出文献间的相互联系。也可以对文件夹中已

有的 PDF 文件进行全文分析，还可以自动提取 PDF 文件中的文献信息。Quosa 还能追踪最

新的进展，发现新的文献能主动提醒。该软件缺点是目前支持的数据库资源较少，对生命科

学数据库支持较多。 

本书分别以这三种软件的最新版本为例进行介绍，但由于软件以及所介绍的数据库随时

都可能更新，你看到的界面可能会与书中的图有所不同。相信这些不会影响你学习和使用这

些软件。 

书中的内容并没有按照软件原版的说明书那样面面俱到的介绍，而是根据个人使用经验

进行提炼和总结，我们力求以最简单的方式表达出最重要的内容。由于个人的使用经验往往

比较局限，这次编写这本书我们组织了六人的小组，希望能尽可能多地满足读者的需求。 

本书分为三部分，分别介绍 Endnote、RefViz 和 Quosa。其中 Endnote 部分最为详细，

分为基本功能和高级功能两部分。建议初学者认真学习基本功能部分，并熟练掌握。高级功

能部分建议选择性学习，或者需要用到某一部分功能时再详细学习。但对高级功能部分的内

容有个大致的了解还是有必要的。Endnote 部分还编写了疑难解答，如果碰到问题可以查阅，

如果该部分没有提供你想要的答案，可以到相关的网站/论坛或 QQ 群以咨询。 

RefViz 的主要功能是用来处理大量的文献信息，以及发现文献间相互关系。第十一章

是软件的基本功能介绍；第十二章介绍了界面及菜单，帮助大家熟悉软件的操作；第十三章

翻译了原说明书中提供的部分应用实例。依据作者的经验，即使你熟悉了这几章的内容，并

不代表你已经熟练掌握了这个软件。这个软件的操作并不难，关键在于你要能够理解 Galaxy



 

视图、Matrix 视图、Topic 以及 Serach Tool 等相互间的关系。只有理解了各部分之间的内在

联系，才能从软件中得到你想要的信息。所以学习这个软件，需要读者仔细揣摩。 

在 Web of Science 网站，以及 Scoups 网站上都提供了一定的分析功能，但均不能对文

献内容进行分析，因此，RefViz 有自己的特色和优势。 

Quosa 是一款全文分析软件，可以下载的 PDF 文件进行分析，也可以对已经下载到本

地的 PDF 文件夹中所有的 PDF 文件进行分析。Quosa 提供的 PDF 全文自动下载功能可以为

我们节约不少的时间。另外，该软件还可以根据用户的设定，自动追踪最新的相关文献，节

约了我们每天去浏览网站的时间。该软件还能够识别 PDF 文件中的文献信息，对于我们利

用 Endnote 管理全文方便了很多。 

由于作者对这个软件也是刚刚开始学习，很多内容不甚了解，介绍的内容也比较少。建

议读者通读这一章，在此基础上进一步学习软件的其它功能。 

三个软件是相互补充的，功能各有侧重，建议科研工作者学习并掌握这几款软件。文献

信息分析对我们的科研生涯是至关重要的。把握全面、前沿的信息，尤于站到了巨人的肩膀

上。相反，不能快速了解和把握前沿的信息，我们的很多工作可能都是在低水平重复。获取

信息速度和获取信息的质量决定了一个人起步的高度。快速获取信息，让我们在激烈的竞

争中领先一步。 

当写完书中的内容时，总觉得还有很多非常重要的内容没有写到。譬如如何综合运用这

些工具，以及如何解决研究生和教授所面临的信息问题等。书中也缺乏很有代表性的综合分

析实例，这些不是我个人能很好解决的。信息的可视化分析本身也是一门新兴学科，用到具

体科研中还需要一段时间的摸索。文献信息分析是需要一定的积累才能灵活把握的。我们会

不断积累经验，提高自身素质，并将自己的经验与大家一起共享。书中所发现的错误以及将

来更新的内容我们会发布在论坛上，欢迎大家常光顾我们的论坛（http://biotech.ustc.edu.cn），

并希望您能为论坛这样一个共同的交流平台的发展贡献一份力量。 

放下自己的实验和其它工作，来撰写这样一本书，希望能为提高科研工作者的信息处理

效率尽一份力，为中国的科技进步尽一份力。  
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第一章 EndNote 软件简介 

EndNote 是 THOMSON 公司推出的最受欢迎的一款产品，是文献管理软件中的佼佼者。

不管是和其它公司的产品相比，还是与 THOMSON 公司的另外两款软件 Reference Manager、
Procite 相比，EndNote 显然受更多人的喜爱。 

常见文献管理软件有 THOMSON 公司的 EndNote，Reference Manager，Procite，以及基

于网络的 refworks。其中 EndNote 是最受欢迎最好用的软件，Reference Manager 提供网络功

能可同时读写数据库，Procite 提供弹性的群组参考及可建立主题书目。中文文献管理软件

中 NoteExpress 是目前较好的中文文献管理软件。 

一、EndNote的基本功能 

EndNote 通过将不同来源的文献信息资料下载到本地，建立本地数据库，可以方便地

实现对文献信息的管理和使用。工作原理如下图所示： 

 

通过将不同来源的数据整合到一起，自动剔除重复的信息，从而避免重复阅读来自不同

数据库的相同信息。同时可以非常方便地进行数据库检索，进行一定的统计分析等。另一个

重要的功能是，在撰写论文、报告或书籍时，EndNote 可以非常方便地编排参考文献格式。

还可以非常方便地做笔记，以及进行某一篇文献相关资料的管理，如全文、网页、图片和表

格等。 

整个软件的架构主要包括数据库的建立，数据库的管理和数据库的应用三个方面。 

功能模块 程序模块 基本功能 其它 

 
数 据 库 建

立 

数据库建立的四种方式及注意事项，检索（通配符，

起止年代，检索策略的储存与调用），拷贝，复制，

删除，添加，全文管理，网址，图片等，转换，，

连接的更新，及设定 

文献管理 
数 据 库 管

理 
重复，排序，统计，分析，查找，栏位显示查找重

复，export 
撰稿引文

编排 
数 据 库 的

使用 
如何引用文献，引用的几种方式，输出格式，论文

模板，自行设定 

常 见 问

题 的 处

理，及其

它 注 意

事项 
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学习并掌握文献管理软件，可以提高我们阅读文献，获取信息的效率，可以省去撰稿文

稿时手动编排文献的麻烦。同时 EndNote 可以非常方便地作笔记，并对笔记进行管理。为

我们撰写综述，或阅读大量文献时提供了极大的方便。 

二、EndNote X1 的新功能 

(一)、在数据库文件（Library）中建立群组（group），便于浏览和管理文献。 

每一个 EndNote X1 数据库中可以建立最多 50 个自定义群组（group）。为了便于管理，

可以将不同分类的文献从 All references 中拷贝、粘贴或直接拖拽到相应的群组（group）中。

而系统也会自动在检索结果、文献导入、从 EndNote Web 和 ISI Web of Knowledge 导入参考

文献时自动做分类。 

(二)、Microsoft® Word 2007 中的 Cite While You Write(TM)功能 

Word 2007 Windows 版本里在会出现一个 EndNote X1 的菜单。这个菜单取代旧版的工

具栏，让使用频繁的 Cite While You Write 功能更容易找到而且只要点一下就可以使用。 

(三)、在数据库文件中更详细的浏览和管理 

在 Library 列表视窗中即可呈现所有作者，从而可以更详细的浏览。Link to PDF 一栏更

改 File Attachment，每个参考文献可以储存 45 个文件。自定义的文献类型也可以更轻松地

在不同电脑间导出和导入。搜索窗口的字体以及文献栏标签也可以自行设定。 

(四)、其它新功能 

 工具栏新增的快速搜索功能可查找所有栏目（field） 

 在 File Attachment 一栏可看到文件名称 

 确认新的参考文献预设偏好的改变 

 工具栏中的 Connect 改名为 Online Search 

 输出格式 Show All 改名为 Show all fields 

 Image 一栏改名为 Figure，对应于 Cite While You Write 中的 Insert Figure 功能 

 主题书目(Subject bibliographies)包含参考文献类别一栏 

 自动转换 Procite 数据库至 EndNote 数据库 

 工具栏中的 Transfer references 更名为 EndNote Web 

 Electronic Resource Number 栏更名为 DOI 栏 

 与 MS Word 插件如 Snag-It 和 FlashPaper 更好的兼容 

(五)、全新方式查询、收集参考文献 

您可以很快使用 EndNote Web 与同事合作。一篇文章中可以同时引用 EndNote 和

EndNote Web 的文献并转换 libraries。EndNote X1 包括全新以及更新后的数据库查询资源、

导入文献和书目格式设定。您可以找到 1500 多个数据库连接设定文件、600 多个导入格式

以及 2800 多种期刊格式。 
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第二章 数据库的建立 

本章内容导航 

数据库建立是文献管理及应用的基础，所以本章首先介绍如何建立数据库。建立数据库

就是将不同来源的相关资料放到一个文件中，汇聚成一个数据库文件，同时剔除来源不同的

重复文献信息，便于分析、管理和应用。 

本章首先对程序主窗口进行了简单介绍，然后，介绍了几种建立数据库的不同方法。 

一、EndNote程序主界面简介 

在介绍数据库的建立之前，简单介绍一下程序的主窗口。运行 EndNote 后，出现的第

一个界面如下： 
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    在以上窗口中选择要打开的数据库文件，也可以新建一个数据库文件。点击 cancel 不

打开任何文件。在上图中点击 OK，就会打开 CuZn 的数据库文件，进入后界面如下： 

 

群组 

文献信息，每一行

代表一条文献 

以选择的输出格式预览选定的文献 

在上面窗口中，用鼠标双击某一条记录就可以显示该记录的详细信息，并且可以进行编辑。

EndNote 中一般的设定会被及时保存，设定完毕或输入完毕，关闭即可。 

二、数据库的创建 

下面我们以新建一个名为 SPR 的文献数据库文件为例，来介绍如何建立本地数据库。

新建数据库的方法可以在启动程序时选择 Create a new EndNote Library，也可以在程序的主

界面，选择 file－new，选择文件保存地址并输入文件名。 

 
中国科学技术大学生命科学实验中心网络发行，下载地址 http://biotech.ustc.edu.cn  
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新建的空数据库文件如下： 

 

数据库建立的第一种方式：手动输入建立数据库 

EndNote 软件中建立数据库的方式有四种：手动输入，直接联网检索，网站输出，格式

转换。 

手动输入主要针对少数几篇文献，无法直接从网上下载，或者一时的想法等。手动由于

工作量较大，无法应付大量的文献工作。 

在上图中点击快捷键 New Reference，也可以在 references 菜单下选择 new reference。
New references 的界面如下图。 

输入文献的信息窗口如下图所示，每条文献记录有多个字段组成，包括 Author、Year、
Title 等。下拉菜单显示的是文献的类型，选择文献类型是期刊论文（Journal Article）、或是

书（Book）、或是专利（patent），所显示的字段会有所差别。EndNote X1 中提供 39 中文献

类型。 

手动输入文献信息方式比较简单，首先选择适当的文献类型，按照已经设好的字段填入

相应的信息即可。并不是所有的字段都需要填写，可以只填写必要的信息，也可以填写的详

细些。注意：人名的位置必须一个人名填一行，否则软件无法区分是一个人还是多个人名，

因为各个国家人名的表示差异较大。关键词的位置也一样，一个关键词一行。 
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如下图所示，输入完毕，点击右上角的关闭即可。 

 

作者姓名按图中格式输入，如果作者已经存在于当前数据库中，输入的人名会显示为黑色，

如果作者名第一次输入则显示为红色。一条记录输入完毕，点击右上角关闭即可。该记录在

主窗口显示如下： 
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关于 PDF 文件，网址以及图片等等的管理，如何链接到一条记录将在本章末尾讲述。 

 

数据库建立的第二种方式：用软件直接联网下载  

第一步：设置常用数据库 

设置常用数据库，如下图所示： 

 

打开数据库链接（open connection manager），出现下面的界面，选择常用的数据库，点

击关闭。 
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第二步：联机检索及检索策略 

，tools－connect－下面，选择 PubMed 就可连接到

PubMed 网站进行检索相应的文献了。 
上面选定的数据库链接就会出现在

 

上图中点击 PubMed，如果你的计算机能够链接到 PubMed 网站的话，就会出现如下的

检索框： 



文献管理与文献信息分析 罗昭锋 韩敏义等编著     版本 1.00 

中国科学技术大学生命科学实验中心网络发行，下载地址 http://biotech.ustc.edu.cn
 

  9

 

 

 

此时你可以象链接到网站一样方便地进行检索了。检索时注意检索词之间的逻辑关系。 

如果是跨时间段检索，注意在两个时间之间用英文冒号隔开。在 PubMed 中支持具体日

期格式，可以检索某两天之间的文献，如 2006/01/01:2006/06/30；在 web of science 中只支

持年代，只能检索两个年代之间的资料，如 2003:2004,表示检索 2003 和 2004 年的相关文献。

有些网站可能不识别冒号，可以用短横线“-”连接，如 2003-2004。 

在检索窗口的左下方有一些命令，可以通过这些命令来增减检索栏位的多少，如果需要

用同样的检索条件检索不同的数据库，可以将检索策略储存，在检索其它数据库时简单调用

即可。当检索条件特别复杂的时候，这样可以节省每次输入检索条件的时间，还避免了可能

误输入产生的错误。需要注意一点的是：不同数据库提供的检索字段有很大差别，如上图

PubMed 提供了 24 种检索栏位，还可以搜索所有栏位；而在 web of science 中，只提供了 6
种检索栏位，如下图所示，如果直接调用 PubMed 中的检索策略到 WOS 中检索，会产生一

些错误，因此，需要做一些调整。 

 

输入待检

索的内容 

输入待检

索的内容

检索策略的储存与调用

增加或删减检索栏位

选择相应的

逻辑关系 

当前的远程数据库
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    在上面 PubMed 检索框中，点击 search，将会返回检索结果： 

 

表明共检索到 614 条符合条件的记录，点击 OK 即可全部下载。在上面两个方框中也可

以对数字进行修改，如将 614 改为 10，将只下载前 10 条文献记录。检索到的文献按时间顺

序依次排列，排在前面的表示较新的文献，排在后面的时间久远一些。 

点击 OK，出现下载界面： 

 

待下载完成可以新建一个数据库，或者拷贝到已经存在的数据库中。注意，上面下载的

界面中，文献只是暂存，如果直接关闭这些信息将丢失，如果需要全部或部分信息，应将需

要的部分信息加以保存。  

关于检索栏位的增删，检索策略的储存与调用请自行摸索一下。 

数据库建立的第三种方式：网上数据库输出 

目前有很多网上的数据库都提供直接输出文献到文献管理软件的功能。如 Scopus，web 

已
下
载
文
献 

将下载的文献拷贝到目标数据库 

下载进程，共 614 篇，已下载 201 篇 
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of science 等。Web of science 可以直接输出到 EndNote，而 Scopus 则需要通过格式转换才能

正确地导入到 EndNote 中。下面以这两个数据库为例加以说明。 

从 web of science 输出文献资料 

链接到 WOS 数据库，输入检索词 SELEX，共检索到 490 条参考文献： 

 

在右边选择要输出的记录范围，然后点击 EXPORT TO REFERENCE SOFTWARE，将

会进入如下界面： 

 

 

当文件传送到本地之后，会跳出一个选择目标数据库的窗口： 
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    选择你要将这些资料保存到哪个数据库，选定之后，点击打开即可将 WOS 网站上的资

料输送到目标数据库中。 

从 Scopus 输出文献资料 

连接到 Scopus 数据库，检索 SELEX： 

 

检索结果如下： 
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共得到 585 条记录，这里选择 page，即选定当前页，共 20 条记录，点击 output。 

 

注意从 Scopus 输出文献时，由于 EndNote 中没有与 references 对应的栏位，所以输出时不要
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选择 references，否则导入时会出现错误。Export for 那里要选择 RIS 格式，点击 Export，选

择输出位置和文件名，例如 scopus.ris。打开 EndNote 软件，选择 file－import： 

 

转换进行中： 

 

导入完毕，20 条记录全部显示在数据库中，如下图所示： 
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数据库建立的第四种方式：格式转换 

通过格式转换相对来说是种比较麻烦的方式，不是迫不得已，一般不会采用的。格式转

换一般把资料保存为文本文件，然后导入到 EndNote 中。要选择正确的 filter，否则无法正

确转换。 

对于中文的文献资料信息，可以先保存为文本，按照 EndNote 程序的要求进行一定的

替换，然后再导入即可。具体方式请参见英文说明书。也可以利用 ultraedit 来编写宏，实现

自动替换。目前需要这样通过文本转换的主要是中文文献。在我们的网站上提供了一些文献

信息转换的工具，请大家参考下载使用(http://biotech.ustc.edu.cn/forum)。 

下面分别以 PubMed 网站的文献转换和中国学术期刊网的资料转换为例进行说明。 

PubMed 数据库文献格式的转换方法 

连接到 PubMed 网站，并进行检索，检索结果如下图所示： 

 

将上图红色标记的位置改为 PubMed，文献记录将显示为: 
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将第二个标记的地方 send to 下拉菜单的地方选择 Text，将会出现如下格式： 

 

将上述窗口保存为纯文本格式的文件，或者拷贝粘贴到记事本里，保存为纯文本文件。

然后通过 EndNote 里的 import 导入即可。 

在 EndNote 主程序界面，选择 file－import，选择要导入的文件和转换格式，import 即
可。整个过程如下图所示： 

 

 

如果你需要的格式不在下拉菜单中，请选择 Other Filters： 
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在 other filters 的界面，选择 PubMed（本例中），点击 choose，回到转换窗口： 

 

Import 后，文献将全部导入到 EndNote 数据库中。 
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中文学术期刊文献的转换方法 

中文文献资料导入文献管理软件一直是个头疼的问题，目前在我们的网站上提供了一些

方法或插件，请读者自行下载使用。另外，还可以通过手动转换的方法，可参考《Endnote X
中文用户手册（试用版）》或英文原版说明书。因为转换方法比较麻烦，这里不作详细描述。 

三、附件的管理 

EndNote 中涉及的附件可能有 pdf、图片、word 文档、网页、表格等。EndNote 管理附

件的方式有两种，一是将附件的地址记录在 EndNote 中，需要使用时打开链接即可；二是

将文件拷贝到 EndNote 相应数据库的文件夹下面。第一种方式不对文件进行备份，占用空

间小，但数据拷贝时，会引起链接对象的丢失；第二种方式需要将文件拷贝一份到数据库文

件夹中，占用一定空间，数据库转移时能将附件一同带走，较为方便。对目前硬盘空间足够

大的情况下，建议尽量用后一种方式管理附件。 

 

上图 URL 的位置，可以通过超链接的方式管理全文，在该界面的任意地方单击右键，

URL－Link to URL 添加链接；该连接可以是网址，可以是文件的相对地址。如果是网址，

可以通过拷贝网址，然后直接粘贴的方式添加链接。 

File Attachment 是 EndNote X1 新增加的功能，专用于管理 pdf 附件。可以通过右键的

File Attachment－Attach File…添加，也可以直接拖拽的方式添加。也可以通过拷贝粘贴的方

式添加。注意这里可添加的附件并不局限于 PDF 文件，可以是图片，音乐或其它文件等。

添加到这里的文件也会被拷贝到数据库的文件夹下面。注意：在该栏位中最多可以附加 45
个不同的文件。 

如果是图片可以通过右键 Insert figure 的方式管理。注意 figure 下面只可以添加一个文

件或图片。这里的文件也不限格式，可以是多种文件。      

将网址或文件的地址链接

在这里，以后点击即可打开 

可以拖拽或通过右键菜单

添加文件 
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第三章 数据库的应用 

一、如何利用数据库来撰写论文 

EndNote 功能之一是在你撰写论文或书籍时，可以自动为你编排文献格式，如果手动

修改。要完成这项任务，需要你的电脑已经安装 EndNote 和文字处理软件如 word 等。打开

word 和 EndNote。（请读者注意这里是以 word2007 为例，在 word 其它版本中某些操作略有

差异）。 

 第一种方式，在 word 中将鼠标指在要插入文献的位置，然后切换到 EndNote 程序中，

选择要引用的参考文献，点击工具条上的 Insert selected citation(s)，即可将选定的文献

插入到该指定位置；  

其它文献插入依此类推，待全部文献插入完毕，点击 Update Citations and Bibliography 

 

将进入如下画面： 
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点击确定之后，word 文档中的参考文献就会按照设定的杂志格式编排好。 

 第二种插入文献的方式：Copy-paste 

在 EndNote 数据库中，选择要插入的文献，右键单击，选择 copy，回到 word 中，右键

单击要插入文献的位置，然后粘贴即可； 

 第三种方式 查找方式，利用 find citation 快捷键，点击后出现如下窗口： 

 

以上这种方式既可以插入一篇文献，也可以同时插入多篇文献。 

 第四种方式，可以利用 EndNote 中的 CWYW/Add in 快捷工具条来实现插入： 

在 EndNote 主程序界面，按如下方式设定： 
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在 word 中将鼠标指在待插入文献的位置，选定要插入的文献，在 EndNote 中点击上面

的 insert citation(s)快捷键，即可将文献插入在相应的位置。 

待全部文献插入完毕，按第一种方式中所述的方式，选择特定的期刊，即可将参考文献

排列成该期刊指定的格式。 

 

二、利用论文模板撰写论文 

EndNote中除了提供两千多种杂志的参考文献以外，还提供了 200多种杂志的全文模板。

如果你投稿的是这些杂志，只需要按模板填入信息即可。 

下面以投稿 nature 杂志为例，说明如何利用全文模板： 

 第一步：Tools－Manuscript Template，选择要投稿的期刊。这里选 nature， 
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 第二步 输入完整的文件名 
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第四章 Filter(滤镜)的操作 

如果大家用过前面章节的通过“格式转换”的方法（File-Import）建立Endnote文献库方

法，那么对Filter(滤镜)肯定不会陌生。Endnote内置了很多导入选项和大量的可以设置的导

入Filter(滤镜)，那究竟什么是Filter(滤镜)呢？Filter(滤镜)就是为从特殊的联网或光盘文献数

据库中导入题录而设计的，导入时选择的Filter(滤镜)用来解释你从联网或光盘数据库中下载

的数据文件中的信息。因为不同的联网或光盘数据库都有自己不同的组织文献信息的字段，

因此不同数据库要有不同的Filter(滤镜 )来导入你下载的数据文件，当然你可以从

http://www.endnote.com下载最新的相应数据库的Filter(滤镜)，这些大多是外文数据库的，对

于中文数据库如cnki、vip就需要自己创建Filter(滤镜)来导入这些中文题录了。本章接下来以

维普数据库中下载的题录为例教大家如何编辑和创建导入时用的Filter(滤镜)。导入的过程见

前面相应的章节。 

首先，我们来看一下从维普中下载的题录文摘数据文件格式（如何从维普下载题录文摘

参考前面章节）。 

 

在这里一共选了５篇文摘下载，仔细看一下就会发现在每篇的格式都是相同的，都是由

“题名”，“作者”，“机构”，“刊名”，“文摘”几项组成的。我们的任务就是让这些字段和

Endnote 中字段对应起来，如“作者”对应“Author”，“刊名”对应“Journal”等，唉，要

是 Endnote 也认识这些中文字段就好了。具体怎么做呢，不必着急，听我慢慢道来。如果手

头有相似的 Filter(滤镜)，我们可以更改让它符合我们的要求，如果没有呢，不用着急，我

们另起炉灶，不要害怕，很简单的哟！ 

 

第一步，新建一个 Filter(滤镜)，点击菜单 Edit-Import Filters-New Filter…，如下图所示： 

http://www.endnote.com/
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出现下面的画面，我们主要就是在这个页面中进行设置，怎么样，内容不算多吧，实际

上对中文文摘来说，需要设置的也就几条，对于外文的数据库中下载下来的文摘就要麻烦些

了，为什么呢？因为在外文期刊论文的作者和书籍的编者有的是名在前姓在后，有的正好相

反；而且更加 BT 的是，有时第一作者和第二作者的姓和名的顺序都不一样，还有要姓缩写

或名字要缩写了等等，烦都要烦死了，幸好我们是中国人（可以自豪一把了：）），都是姓在

前名字在后，这样“Author parsing”和“Editor parsing”就可以简单的设一下就行了。其实，

在 Filter(滤镜)中主要操作的是 Template 这个项目，啰嗦了这么一大堆，可能大家都烦了，

好了，下面正式创建我们的 Filter(滤镜)。我们一项一项来看： 

第一项是“Ａbout this filter ”，主要是讲这个 Filter(滤镜)的一些相关信息，都是些无

关紧要的东西。 

 

 Name: 点击 File-Save as… 给这个 file 起个名字吧，如下图，用的是维普的题录，就

用 vip 这个名字吧，注意不要与 endnote 安装目录下的 Filters 中的其他文件重名，要不
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然它会六亲不认的，点击“保存”，现在“Name”这个位置上就是我们刚才起的名字了，

在创建修改 Filter(滤镜)过程中要注意存盘，点击 File-save，就 OK 了。 

 Based on：这个 Filter(滤镜)是在哪个基础上修改而成的，随便写点什么都行。 

 Category：分类，属于哪个类别的，写“中文期刊”吧，别的也可以，只要你高兴。 

 Created 和 Last modified 是系统自动生成的两个时间，我们不用管它。 

 Comments and limitations：评价和局限，也是对这个 Filter(滤镜)做一个注释吧，太懒了，

空着也没有问题。 

 

注意了，下面进入最最关键的步骤了 

第二项：Template 闪亮登场。 
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Reference type：指导入的文献类型，可以点击“journal article”选择适当的文献类型。

用得最多的是“journal article”，而我们下载的维普题录也是期刊文章，所以这项就不用改

了。在一些大型数据库中往往有多种文献类型，我们就得在同一个 Filter(滤镜)中为各种类

型的文献建立相应的对应关系。 

  下面我们就来修改主要的部分，Ｔag 和 Field(s)，Tag 是我们下载的题录中的字段，而

Field(s)是对应的 Endnote 中的字段，我们要做的工作主要就是让他们对应起来： 

 

首先我们从维普题录中复制第一个字段（包含字段前后的空格也要复制），“【题 名】”，

粘贴到 Tag 下面的空格中，移动光标到 Field(s)下面的空格中，然后点击“Insert Field”，在

弹出的菜单中选择和“【题 名】”对应的 Endnote 中的字段，点击 “Title”，第一条就这样

对应好了，是不是很简单，在 Title 上回车，出现下一行。如果填错想删除某一行时，只要

选中这一行，点击 Edit-Clear 就可以了。同样的方法对应其他的字段。最后的结果如图所示。 

值得注意的是这种对应可能是一对多或多对一的对应关系，例如在维普中“【刊 名】”

就对应了 Ednote 中的“Journal.Year,Volume(Issue).-Pages”，在这种对应中必须保证原字段中

的符号和 Endnote 的符号严格一致，如本例中的“.”、“,” 、“()”、“-”。而且中文期刊中有

的有卷有的没有，即有的是“年，卷（剘）.－页码”，有的是“年（期）.－页码”，这样在

tags 中就会出现两个“【刊 名】”，另一个对应的是“Journal.Year(Issue).-Pages”，这样也是
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允许的，否则会导致导入文献时失败。有时在制作 Filter(滤镜)时发现下载的题录中有些字

段在 Endnote 中找不到对应的字段，例如我们导入硕博论文时其中有个字段是“专业”或“学

科”，这时可以有三种解决办法，一是让它对就于“{IGNORE}”这个字段，也就是忽略它，

二是让它对应于“Notes”（外文数据库题录中就是这样处理的），三是修改 Endnote 中的字

段，让它和我们下载的题录相对应，如何修改 Endnote 中的字段见后面相应的章节。 

 

维普中的最终结果： 

 

好了，最麻烦的部分我们已经完成了，可以休息一下了。 

后面的部分最简单多了。 

 Author parsing 和 Editor parsing 内容一样，主要是告诉 Endnote 是姓和名字哪个在前，

哪个在后面和作者之间用什么间隔的。 

 Name order：名字的顺序。Last always Precedes First：名在前姓在后。First always Precedes 
Last：姓在前名在后。Name order is inconsistent:名字顺序不一致。主要是针对外文期刊

来说的，中国人不存在这些问题。 
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 Interpret First Name As: Smart:智能处理。Whole Names：全名。Initials Only：词首字

母大写。 

 Author Name Seperator：作者名间隔符。Between Authors：作者之间以什么间隔。Smart:
智能处理。Space：空格间隔；Return:回车间隔；Import As Is：直接导入；Other：其它。

选择其他时后的空格可以填写作为作者之间分隔符。Last & First Names：名和姓之间

的分隔符。 

 Parenthetical Ｄata in Author Field:作者中的括号内的数据，主要是对外文文献来说的，

如书籍中的编辑后面加“（ed）”。Discard：忽略。Import Into:导入到指定的字段中。 

 

 Continuation Lines:连续行判断。让 Endnote 知道从哪里开始了一个新的字段还是只是进

行了换行。 

 Ignore Indents: Untagged lines are always a continuation of the preceding line：忽略缩进，

没有标记的行是前一行的继续。 

 Continuation lines must be indented：连续行必须缩进。选择了本选项后下面的就可以选

了。Smart Indent Identification：智能缩进识别，让 Endnote 来决定吧。Indented spaces：
指定缩进几个空格。 

根据实际情况来选择。在维普中选择第一项就可以了。 
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 Reference Type：默认导入的文献类型，根据实际情况进行选择。本例就选择 Journal 
Article。 

 Identifiers：识别器。当题录包含从多个数据库下载的文献或一个数据中包含多种文献

类型时用这个信息来辨别正确的 Filter(滤镜)。可以根据不同题录中的信息为不同的文

献类型设置相对应的标签和文本。维普中没有提供这些，所以我们也就不用设置它了。 

 

 Field Editing:字段编辑。主要也是对外文文献来说的，对题目(Title)等字段的大小写进行

调整。 

 Enter text to be omitted:输入被省略的。即不需要处理的符号或文本。每行只能输入一条。 
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 MARC Records：机读记录，与我们关系不大，不用管它。如果你是从你们图书馆下

载的馆藏图书记录，可能需要设置它了。 

 Record Layout:记录布局。让 Endnote 知道什么时候是一条新的文献了。 

 Smart Record Identification：智能记录识别。大多数情况选它就可以了。 

 

 Source Parsing:来源分析，指定期刊文章的标志，对本例来说默认即可。 
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好了，我们的第一个 Filter(滤镜)就做好了。最后试试，用你的 Filter(滤镜)导入，看看

能不能导入。具体导入过程大家参照前面相关章节 

我们知道如何创建一个新的 Filter(滤镜)，那么更改 Filter(滤镜)就更简单了，在 Filter(滤
镜)管理器中找到与我们下载的题录的最接近的一个，打开它，然后在点击 File-Save as …，

存为另一个文件，再在它的基础上进行修改就 ok 了。 
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第五章 Style操作 

学过了前面的章节，我们知道了什么是 style，一般而言，不同的杂志有不同的 style，
Endnote X1 软件也自带了很多 style，但是万一我们要投稿的杂志在 Endnote x1 没有对应的

style 怎么办呢？本章就来教大家如何来解决这个问题。 

遇到这种情况，我们有几种解决的办法：一是到 Endnote 的官方网站去下载最新的 style，
如果幸运的话，可能正好有你所需的呢；二是找一个和你的杂志要求相近的 style，然后根

据需要来修改；三是另起炉灶，自己新建一个适合自己杂志的 style,然后再上传到小木虫，

还可以挣至少两个金币呢。难度是顺序增加的，如果运气好的话，endnote 网站上正好有，

最简单了，自己做一个是最麻烦的了。具体怎么做听我慢慢道来。 

第一种方法 下载最新的style 

登录Endnote的官方网站http://www.endnote.com/support/enstyles.asp，如图。你可以在

Publication name中输入期刊的命名进行搜索，如果正好找到的话，恭喜你了，下载下来，放

到endnote x1 安装目录下的styles目录下即可使用；或者，你也可以利用Suggest向Endnote公
司提出要求，让他们给你做一个style。 

 

http://www.endnote.com/support/enstyles.asp
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第二种方法 利用相近的style进行修改 

如果在Endnote网站找不到你要投稿杂志的style，而且你给Endnote公司写了Suggest，他

们没有回应，那么接下你可以在Endnote自带的许多期刊中找到一个和你的杂志要求类似的

格式进行修改。以我国的期刊为例，我们的参考文献排列要求大都为如下格式：[1] 作者.
题目.文献标题.年，卷（期）.页码，有的还要在文献标题后注明文献的类型如[J]代表期刊，

[M]代表书籍等。而在正文中则表示为文献出现的顺序号，格式为上标。如“正常水的pH为

小于 7[1]”。 

打开 Style 管理界面， Edit>Output Styles>Open Style Manager。如图所示： 

 

进入后，点击右下角的的 按钮，使下方出现该文献 style 的预览窗口。 
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用鼠标点击上面不同的 style，找到一个和我们要求相近的 style，在本例中我们发现 Number

这个 style 和我们的要求差不多，就它了吧，然后点击右下角的 打开它，接着把

它另存为另外一个名称，以免覆盖原来的 Number 这个 style。如图： 

 

在开始修改之前，我们先来看一下 style 的结构： 
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下面对各项进行详细说明： 

项目 1--Anonymous Works：指在文献库中作者的栏位为空白的文献，对于这样的文

献，Endnote有下面几种解决方法： 

 

→关于本 style 
→作者栏位为空白的文献 
→页码显示方式 
→期刊名显示方式 
→Citations：用于设置正文中引用文献的

标志 
 
 
 
 
→Bibliography:用于文章末尾参考文献

的显示格式 

 

 

 

 

 

 

→Footnotes:用于文章末尾或页面末尾的

脚注显示格式 

 

 

 

 

 

 

→Figures & Tables 修改图表的说明 
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Leave author blank (作者栏保留空白) ： 

如下面的文献：  

 

Use full/short title in place of author (以完整/短题名取代作者栏) 

 

 

Use APA specifications (用美国心理学会定义的格式) 

如下面的文献 
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Insert Text: Anonymous (以文字取代作者栏) 

 

项目 2--Page Numbers：在此项目中改变页码的显示方式。 

 

项目 3--Journal Names 

您可在此项目中改变期刊刊名的显示方式。这些主要是对外文期刊来说的，对于中文期

刊不存在这们的问题，对本例来说选默认的就可以。 

 

 Use full journal name (使用全称) 

如下面的文献 

→不改变页码 
→仅显示首页 
→缩写尾页 

→缩写尾页，但保留两位数字

→显示全部页码 

→对期刊仅显示首页，其它全

显示 
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注意：当你选用"full journal name"但 format 后出现缩写名, 很有可能是原始文献资料的

Journal 栏位是以缩写形式录入（或导入的） 

Abbreviation 1-3(缩写的三种形式)，如： 

 

 

 

注意：当你选用"Abbreviation"但 format 后无法出现缩写刊名，请按照下面的方式将"Journals 
Term List"导入 

Endnote 工具栏中 Tools>Open Term Lists>Journals Term List>切换到 Lists 标签>Import List>
打开 Medical.txt(位于 Endnote x1 安装目录中的 Terms Lists 文件夹中，详细操作请参见后面

章节) 

Don't replace (显示文献库中"Journal"栏位的内容) 
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项目 4—Citations 

本条目可编辑修改 Citation 的显示方式。即引文在正文中的显示格式。见下图： 

 

项目 4--Citations...Templates 

模板的设定。对于中文文献，大都是“[1]”为上标的格式，具体操作见下图： 

 

对于外文文献，citations 的 Templates 中，多数为（作者，年代）这样来表示的。如下图： 

利
用
此
工
具
条
对
栏
位
进
行
设
置 

利用此工具条进行格式设置 

模板 

模板 
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项目 4--Citations...Ambiguous Citations 

当 Citation 较模糊不清时，可利用此选项加强分辨效果，例如： 

 

项目 4--Citations...Author Lists 

此项目定义 Citation 中作者之间的分隔符与人数。 

对于中文文献，作者之间用“，”间隔，而最后作者之前用“和”，当作者大于等于三个

人时，只列出第一作者，后面加“等”（不同期刊要求不同，要看投稿要求）。设置如下图 
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而对于外文文献，大都是要求作者之间用“，”间隔，而最后作者之前用“and”，当作

者大于等于三个人时，第一次出现只列出前两个作者，后面加“et al”，接下来出现时只列

出第一个作者，后面加“et al”。（不同期刊要求不同，要看投稿要求）。设置如下图 

 

那么如果我们引用时既有中文也有外文文献时怎么办呢？这确实是一个很棘手的问题，

最笨的办法是文献插入完成后，去除 Endnote 代码，用 Word 中的查找替换功能改成正确的。

当然还有一些变通的方法，实现起来也很麻烦就不多说了。谁让 Endnote 是老外的产品呢？

我们自己的国产产品 NoteExpress 据说就可以很完美的解决这个问题。 

项目 4--Citations...Author Name 

   此项目定义 Citation 中作者姓名的表现方式。这些设置主要是对老外的名字来说的，对

我们中国人不用怎么设置就可以。 
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项目 4--Citations...Numbering 

此项目可将多个 citation 以连续号码表示或将经常一起使用的 references 先群组起来，

注意:此功能只应用于 templates 中设定为"bibliography number 的情况。 

如文献库栏位内容 

姓名的首字母大字 

姓名都大写 

只有作者的“姓”相同时，首字母才使用 

大小写

首字母 
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项目 4--Citations...Sort Order 
此项目定义 citation 的排序方式。 

 

 

项目５--Bibliography 
目可编辑修改格式化(format)文章中文献资料(bibliography)的显示方式 此项

没有格式化前 

格式化后 

格式化后 

举例 

格式化前 

格式化后 
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项目５--Bibliography...Templates 

此项目为书目资料中参考文献(reference)的模板, 您可在此新增 reference 中包含的类

型、元素及改变它们显示的方式。这也是修改或创建 style 最为关键和重要的部分。设置见

下图： 
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利用此工具条改变 Reference 的格式 新增文献中所需的元素 
新增文献类型 
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Endnote X1 具有笔记功能，我们可以把笔记放到文献的 Notes 字段，QQ 群中有人问，如何 

在文献的预览窗口显示我们读文献时做笔记呢？总不能双击进入某篇文献然后找到 Notes
字段再看吧？我们就可以修改 style 中的 Bibliography...Templates，定位到每种文献类型的最

后（或其它）位置，点击 ，找到 Notes，添加上 Notes 字段，然后在主界面

选用这个 style，这样在预览窗口就可以显示我们做的笔记了。 

 

 

 

 

 

 

 

 

 

 

再看预览窗口： 

 

 

 

1.将光标定位到文献尾部 

2.插入后的结果 

2.笔记的内容就出来了 

1.找到你刚才修改的的 style 
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项目５--Bibliography...Author(Editor)Lists、Author(Editor) Name、Sort Order 

请参考 Citation 的项目说明。 

项目５--Bibliography...Layout 
此处可提供您在一篇文献前后加上文字，也可设定首行缩进的大小。 

 

对于中文的期刊文章的末尾参考文献前有时加带中括号的数字，那么在“start each 
reference with”处的格式就为“[Bibliography Number]”。 

项目５--Bibliography...Title Capitalization 

此项目可选择文章题目大小写样式。主要是对外文参考文献来说的，这些设置对中文文

献没有影响。 

 

项目６--Footnotes 
    此项目可编辑修改注释(Footnote/Endnote)的格式。这些格式在Word中插入脚注(Footnote)

文章末尾书目前加标号 
增加栏位 

在书目后加摘要， 

对于中文期刊不需

要设置此项 

首行缩进范围 

保持文献资料输入时的样子 

题目中的所有单词首字母大写 

题目中第一个单词首字母大写 
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此项

和尾注(Endnote)起作用。详细设置请参见英文的Endnote手册。 

项目７--Figures & Tables 
目设定图表及其说明(或标签)的排版。 

 

项目７--Figures & Tables...Figures/Tables 

此项目可编辑修改图表及其说明放置的位置。 

注意：Endnote 中所有 Output Style 图表的预设值都一样(置于该段落之后)，您可就投稿

格式依个別需求修改预设值。 

 

项目 7--Figures & Tables...Separation & Punctuation 

图表放于引用处附近；该段落的结尾 

图表放于文档的末尾 

图表标题放于图表的上方 

图表标题放于图表的下方 
图表１野生蕈类 

图表１ 

野生蕈类 
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 图表和正文的间距 

 

最后用自己的 style 格式化一下文献，看看和投稿杂志的要求是否一样，在修改或创建

style 过程中最容易出错也是最麻烦的地方是 style 中 bibliography templates 的创建与修改，

尤其是各种文献的格式本身就不一样，有的有卷，有的没有。在格式化就会出现一些问题。

如何解决这些问题，请参考英文的 Endnote 手册中关于 bibliography templates 几条规则的

说明。 

 

 

当图表位于正文中时： 

在图表的上下方加2个空行以

和正文分开 

 

当图表位于文章的末尾时： 

每个图表用一个分页符分隔 

在图表的上下方加2个空行以

和正文分开 

 

图表的间距 

在标签和题目后面加上一个句号 
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第六章 更改EndNote的偏好设定（Preference） 

经常使用软件的人都知道，在功能稍多的软件中都有一个“设置”按钮或菜单来让我们

对软件的外观或功能进行相关的设置（如是不是随 Windows 一起启动，打开软件的同时自

动运行的东西等）。所不同的是，不同软件名称可能不同。有的称为“设置”，有的称为“偏

好”，有的称为“选项”，英文的软件称为“Options”或“Preference”，Endnote 也不例外，

对它的一些设定，称为“Preference”，在“Edit-Preference”中找到“Preference”，如图： 

 

在这个单元，您可以学习如何设定默认库（Default library）、修改参考文献的形态，和改变

参考文献在 Reference library 呈现的型态，创建或修改文献的类型。 

一、添加Endnote启动时打开的文献库 

我们大部分时间，都是同一个文献库中操作，每次启动 Endnote 后还要再 File-Open…
或点击 打到你要打开的库，再继续其它的工作，一次再次还行，多了谁都嫌烦，还好

Endnote 替我们想到了，不用每次都这样操作。启动 Endnote 后，打开以后你需要 Endnote
启动都要打开的库，然后打开 Endnote 的偏好设置(Preference)，在 Libraries 下，点击

按钮，如图，这样启动 Endnote 后就会打开刚才所选的库。如果以后不用

这个库了，要用其它的，那么你也可以点击 ，去除每次都随 启动

都要打开的库。 

Endnote
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二、界面的美化－显示字体(Display Fonts) 

 

在这个对话框中，可以更改文献库窗口中显示的字体和字体的大小。如果你看小字很累，可
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以把字体设置大一点，或者你觉得字体显示的不漂亮，你都可以在这里大显身手，发挥你的

审美优势，彰显你的个性。 

在 这些标签中，library 设置的是文献库窗口的字体及

其大小；General 是设置输入的文本的字体及其大小；Labels 设置的是文献库窗口中字段标

签的字体及其大小；Search 设置的是搜索文献对话框中输入的文本的字体及其大小的。在每

个标签中，点击 后，就会出现字体及大小的选择的对话框，可以进行设置，如

下图： 

 

下面是 Search 改变字体以后的效果： 
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三、文献类型的修改(Reference Type) 

在这时你可以设定默认的文献类型、修改或新增文献类型，导入与导出文献类型。其中

导入与导出是 Endnote X1 新增加的功能。 

 

1. Default Reference（默认文献） 

Default Reference 是指当你点击 而手工输入文献时 Endnote 默认的参考文献类型。大

多数情况下，我们默认为 Journal Article 即期刊文章就可以了。 

2. Modify Reference Type（修改文献类型） 

在说如何修改参考文献类型之前我们先来看看某学报的投稿要求中的文后参考文献著

录格式： 

 

前面几种文献类型是期刊、专著等，在 Endnote 中都能找到相应的文献类型，但后面的“标
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准文献”好像就没有对应的文献类型。那怎么办啊？不要着急，我们可以创建或修改一种已

经存在的文献类型来适合我们的需要。其实创建和修改文献类型的步骤大体上是一样的。创

建就是修改一个在 Endnote 中没有命名或使用的称为“unused 1”或“unused 2”、“unused 3”
的文献类型。而修改就是更改一个已经存在的，但我们没有使用的 Endnote 文献类型。 

我们就以“标准文献”为例看看如何创建（修改）一个文献类型。 

首先点击 ，出现下面的对话框： 

 

在修改文献类型时，如果你想隐藏一种文献类型，那么你只需在“Generic”后面的文

献类型名称的前面加上一个英文的句号就可以了。例如你想隐藏 Map 这种文献类型，那么

只需在 Map 前加一个句号“.”就可以了。可是问题又来了，当你想加句号时，用鼠标单击

或双击这个名称如“Journal Article”时却没有反应，可是双击或单击其他地方却把光标定位

到了其他字段，难道是搞错了？还是Endnote在忽悠我们？据说这是Endnote X1的一个Bug，
在 Endnote X 中直接双击或单击鼠标就可以定位到文献名称的前面。好了，不废话了，临时

的解决办法是先双击或单击鼠标，定位到文献类型下面的字段，如在 Journal Article 中，是

先定位到 Year 中，然后按键盘上的向上的箭头，这样光标就定位到了文献类型这个字段中，

就可以修改文献类型的名称或在文献类型名称前加句号了。 

Endnote 为每种

文献类型定义的字

段 

具体文献类型显示

的字段 
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我们首先单击 ，选择一种没有

使用的文献类型，如 Unused 1，并给它改名为“标准”，如下图： 

然后根据标准文献中有的字段对文献类型进行修改，让 Author 显示为“主要责任者”，让

Title 显示为“题名”等。 

 

 

 

 

最终修改的结果如图所示。点击 ok 后，这样你在新输入一篇文献或在修改 style 时就有

“标准”这种文献类型了。 

我们也可以修改文献类型中字段的名称，把一些不用的字段名称改为我们自己需要的，

例如可以把 Custom1 改为 Number，这样我们可以自己给文献编上号，把Custom2 改为 Status，
来显示这篇文章的状态，我们是否读过这篇文章了。 
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新建文献时有了标

准文献类型 
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注意创建或修改的文献类型只对自己计算机上的 Endnote 起作用，如果你把新新创建的

style 或新建的标准文献直接复制到别人的计算机上再查看时虽然不是乱码，但和你预想也

有很大的差距，那怎么办呢？这就用到了 Endnote X1 中的导入和导出文献类型的功能了。 

3.导入和导出文献类型 

单击下图中的 按钮，导出你刚才新建或修改的文献类型，然后在其他人的

计算机上单击 ，找到你刚才导出的文件。这样，他的计算机上也就显示正常了。

注意他的 Endnote 也必须是 X1 版。 

修改 style 时有了

标准文献类型 
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四、Temporary Citations(临时引文)的表示 

指在 Word 中用 Endnote 插入文献后还没有格式化文档时，在正文中插入参考文献的地

方显示的文字。一般我们默认就可以了。 

 

 

五、Sorting(文献排序)设定 

指在文献排序时忽略的单词，如果我们希望英文文献在排序时完全按字母排序，不管第

一个单词是“a”、“an”或“the”，那么我们就可以选择 Title Filed 下面的框中的“a”、“an”

和“the”然后按 就可以了，如图所示。 

 

 

 作者字段需要忽略

的单词  
文献题目中需要忽

略的单词 
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六、Change Case（更改大小写） 

有时我们想让某些单词总是大写或小写，我们就可以填到下面的框中，不让 Endnote 改

变它们的大小写。 

 

七、Display Field（显示字段） 

指在文献窗口中要显示的字段，默认要显示的是 Figure、File Attachments 和 Author 等，

这些都是一篇文献显示时就有的信息，可是 Reference Type 和 URL 等，不要也可以，那么

我们就可以让它显示为我们自己定义的字段，如刚才修改的 Number 和 Status 等。 

在以前 Endnote 版本中，文献窗口的作者栏中只能显示第一作者，新版中只要勾选

就能够显示所有作者了。 
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修改前文献窗口栏位显示： 

 

修改后： 

 

八、重复文献（Duplicates）标准的确定 

在这里你可以确定两篇文献是同一篇的标准，有时你发现明明两篇文章是重复的，可是

用 Reference－Find Duplicates 查找时，返回的结果却说没有重复文献，有时明明没有重复的，

一查找，却找到 n 篇重复文献，让人很郁闷。毛病就出在这个地方。 

默认的确定两篇文献重复的标准是：两篇的作者、年代和题目相同就认为是同一文献。

你可以添加和减少条件。 

查找重复文献的标准有严格匹配和忽略空格和标点。 

在作者栏位显

示所有作者 
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九、Online（联网） 

主要用来设置 Endnote 默认的网络浏览器，连接日志及 ISI 的网址等内容 

 

十、Folder Locations（文件夹位置） 

用来设置 style、Filter 和连接文件的位置，一般我们选择默认的就可以了。 

设置 Endnote 默认的网络浏览器 
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十一、Term List（术语列表） 

作者、期刊的名称及缩写的相关设置，是否更新术语列表的相关选项。一般我们全选就

可以了。关于 Term List 请参见下章。 

 

 

十二、Spell Check（拼写检查） 

设定拼写检查的一些选项，主要是是否忽略首字母大写的、所有都是大写的、带有数字

的，是域名的等单词，及检查的速度和精度的设置。字典设置中主要是对单词和词典的添加。 

style 文件的位置 

Filter 文件的位置 

连接文件的位置 
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十三、URL & Links（网址和链接） 

选中 之后，当你在References 菜单中选择URL－OpenURL Link子
菜单后后会调用默认浏览器打开http://isi.1cate.com/以下面的对话框中内容作为参数打开你

所选文献的全文（如果有的话），这时打开的网址与你文献的导入的URL无关。 

选项是当你为某条文献记录添加附件时，

是否将文件复制到专门的附件文件夹并创建相对链接，一般我们要选中这个选项。 

 

拼写检查的设置 

字典的设置 

是否复制文件到转为的附件文件夹且创建相对链接 

http://isi.1cate.com/
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十四、Word 2007 中CWYW偏好设置 

 

1．General 标签中的设置 

 

2.Keyboard（快捷键）设置 

点击后出现下面的对话框 点击后出现下面的对话框 

当Word启动时打开Endnote 

当 Word 关 闭 时 关 闭

插 入 文 献 后 返 回

是否激活即时格式化新 Word 文档 

扫描临时引文 

检查已存在引文的变化情况 
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可以为 Endnote 在 Word 中的工具条上的按钮设置快捷键。选中一个按钮的名称，然后

按键盘上的键，再点击 即可，要删除快捷键点击 ，而 使

所有快捷键重置。 

 

3.Figures and Tables（图表位置设置） 

设置插入图表时的位置是在插入图表的段落后面还是在插入点的位置。 

 

图表在首插入位置所在段的后面 

图表在插入点的位置 
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4.Application（应用程序） 

设定 CWYW 使用的程序是 Endnote 还是 Endnote Web，当选择后者时还要输入定购的

网址，E-mail 和密码及是否记住地址和密码。 

 

 

输入地址 

输入Email 

输入密码 
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第七章 Term List(术语列表) 

EndNote 使用 term lists（术语列表）来贮存一些诸如关键词、作者姓名和期刊名称等术

语。你也可以创建其它的术语列表来贮存 Endnote 文献中任何字段的术语， 如标签或笔记。 
术语列表提高了这些字段的信息连贯性。Endnote X1 预置了人文学科、医学和化学领域的

期刊名称列表。如图： 

 

然而这些术语列表不是自动插入到你的库中，你必须导入到你的文献库中，如何导入等会你

就知道了。 

注意：术语列表与每个特定的 Endnote 库有关。如果你有多个 Endnote 文献库你得为每个库

创建术语列表。你可以导出列表，然后在新库中导入它们。你在操作术语列表时 Endnote 库

必须打开。 

一、术语列表的作用 

实用主义告诉我们一种东西要学的话必须有用，要不然我们学它干什么呢？下面我们来

看一下术语列表的作用，是不是值得我们花功夫去学。 

打开一个新输入文献的窗口来录入文献，你输入作者时你会发现当你只输入了一个作者

的前几个字母时后面会提示作者的姓名，类似于输入命令时的自动完成，如图，是不是很方

便。当你输入期刊名称时，你可以通过 Tools-Open-Term Lists-…打开 Journal Term list。 

Endnote X1 预设的术语列表 
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打开 Journal Term List 也可以按快捷键 Ctrl+1,见下图 

 

打开后如下图，利用滚动条找到期刊的名称，然后单击 ，你这时再看新建

文献窗口中的 Journal 字段，就会自动填好了。 

 

另外有些期刊要求期刊名称要缩写，而这些缩写的名称也存放在 Journal Term List 中。 
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二、创建术语列表 

当文献导入或输入完成后作者、关键词和期刊名称的术语列表文件会自动更新。在文献

保存之前术语都会显示红色。文献保存后列表就会更新。术语就会显示为黑色。术语列表总

是和特定的文献字段链接。 

注意：你也可以在偏好设置中关闭术语列表的自动更新。 

你可以创建自己的列表且链接到文献字段，例如创建一个标签术语链接到标签字段。  

1.创建新的术语列表 

依次点击 Tools-Define Term Lists 菜单，如图 

 

点击下图中的 ，输入新的名称（不能和已存在的文件重名，除期刊名称为 4

列，对应于不同的期刊缩写形式，其它列表只有 1 列），输入列表名称，最后点击 OK。 
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如果你想使用新的术语列表链接到特定的文献字段，你必须链接新的术语列表到这个字

段。首先选中你新建的术语列表文件，点击 ，在弹出的对话框中利用上下滚

动条找到要链接的字段，如 Label，然后点击其右侧的向下的按钮，找到刚建立的列表文件

label。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.点击 Create List… 

2.输入名称 

3.点击 OK 

2.点击 Link Lists… 

3.找到对应的字段 

1 选中链接文件 

4.找到列表文件 
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三、.删除与重命名术语列表 

选中术语列表文件后，可以点击 把文件删除或点击 对其进

行重命名。 

 

四、在术语列表中手动输入新的术语 

你可以让术语列表在添加新的文献时自动生成也可以手动输入一个新的术语，手动输入

的步骤是选中添加的列表文件名称，单击 Terms 标签。 

 

打开 Terms 对话框，而后单击 出现输入新术语的对话框。输入新的术语后点击

重命名列表文件 

删除列表文件 

1.选中列表文件 

2.单击 Terms 标签 
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即可。 

 

五、批量输入术语 

他地方复制大量的文本（这些文本必须每个术语单独占一行），而后在你可以从其

EndNote X1 中，单击 Tools-Open Terms List 找到你要添加的列表文件，这不必单击

，直接粘贴就可以了，在粘贴过程中 EndNote X1 会自己检查是否有重复的 Term，

重复的不会被复制过来。 

 

1.单击 New Term… 

2.出现输入新术语对话框… 

找到需要插入术语的文件 
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六、

而后在后面的库中导入术语列

表文

开定义术语 文件对话框，如图，在出现的界面中，选中要导出的 Term List，

而后单击

导入导出术语列表 

除了在输入文献时自动生成和自己手动输入术语到列表中外，我们也可以导入术语列表

文件。而且由于术语列表文件是对于特定的文献库来说的，要想在一个库中建立的术语列表

文件应用于自己其它的文献库也可以通过在前面的库中导出，

件来共有它。 

首先打 列表

。 

 

直接粘贴即可 
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接下来，起个名字就行了，注意不要与其它文件重名。 

 

导入就更简单了，点击定义术语列表文件对话框中的 ，找到要导入的文件名，

点击 就好了，然后出现导入的过程和导入的结果。 

1.选中要导出的 List 

2.点击导出 

2.给文件起名 

1.选择位置 
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导入过程 

 

导入结果 
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第八章 主题列表（subject bibliography） 

Subject Bibliographies 可以根据不同的主题生成列表，可以利用该功能进行一定的统计

分析。例如可以利用该功能列出数据库中每年发表的文章数，通过每年发表文章数的变化可

以看出该领域的发展趋势；通过对作者的统计分析，我们可以知道哪位作者在这个领域做了

比较系统深入的工作；也可以列出所有关键词信息，统计关键词的频率，了解热点方向。下

面以三个例子来介绍该功能的应用：  

1. 不同年代发表文章的统计 

2. 不同作者发表文章的统计 

3. 关键词分析 

 

一、不同年代发表文章的统计 

通过对某一主题每年发表文章数量的分析可以了解到这一领域发展的趋势，该领域是快

速发展的热门领域、还是平稳发展的成熟领域或是已经过时的研究方向，这些都是研究选题

时所关心的重要信息。 

在新版的 web of science 检索结果界面上也提供了按年代、作者、杂志以及领域分类统

计的功能，但这些分析只基于 SCI 的数据库，而 EndNote 可以将不同来源的数据库整合起

来分析。 

EndNote 分析过程如下： 

首先通过 EndNote 打开需要分析的数据库文件，点击 Tool 菜单中 Subject Bibliography，
进入到 Subject Fields 窗口，如下图所示： 

 

在 Subject Fields 窗口可以选择不同的主题栏位，如果选择 year，然后点击右下角的 OK，即
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可对数据库中的文献按发表年代进行统计。在上图中，可以同时选择多个栏位进行分析，如

果选择多个栏位，软件分别对每个栏位进行分析，并给出结果。如果清除选择可以点击右上

的 Clear Selection(s)。 

选择需要分析的栏位 Year，点击 OK 进入分析结果界面，如下图： 

 

由上图可以看出近几年中该领域的文献每年接近翻番（07 年统计结果到 9 月底），表明

该领域是一个快速增长的热门研究领域。以上统计结果可以输出到文件。在上图中点击

Select All，然后点击 OK，会进入如下界面： 
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上图按照你选择的年代，根据年代列出每年的文献。这是默认的显示方式，可以对结果

的显示方式进行修改。此窗口的 Output Style 表示当前文献输出的格式，Layout 可以设置显

示内容和格式；点击 Terms 可以返回到前一界面。通过 Save 可以将结果保存为 rtf、htm 或

txt 文件，也可以通过 Print 将结果保存为 pdf 格式的文件（需要相应的软件支持）。 

在上图中，点击 layout，可以设置显示格式和参数，如下图所示： 
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在 Reference 菜单下，Output 可以设置参考文献的显示格式；Referecne List Title 可以为

你的文献列上一个标题，便于日后分辨你输出的文献内容；Bibliography Sort Order 设置文献

的排列顺序。 

在 Terms 菜单，在 Reference List 这里如果选择 Subject Terms Only,就会只列出统计结果，

该统计结果可以保存成 txt 文件，用 Excel Origin 等软件打开，进行作图以及进一步的统计

分析等。 

 

在上图中，选择 Subject Terms Only，然后点击“确定”，即可将上面例子中提到的统计结果

按 Terms Only 输出，结果如下： 

 

点击 Save 将结果保存为 txt 文件，然后用 Excel 或 Origin 打开，即可进行作图处理。例如将

上面的结果保存为 year.txt，用 Excel 可以直接打开，也可用 Origin 作图: 
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每年发表文章的走势图 

菜单中的 Page Layout 和 Bibliography Layout 是进行显示格式的设置，请读者自行摸索一下。 

二、不同作者发表文章的统计 

分析不同作者发表的文献，可以了解哪些作者是这个领域的真正专家，哪些是初涉这个

领域。以下是对上面同一个数据库进行作者分析的结果，点击栏位标题，可以按照升序或降

序排列。 

 

从上图中可以看出，在该领域中，Gold，L.和 Ellington, A.D.两位发表的文章最多，说

明他们可能是这个领域的权威。实际情况是，这个数据库的文献是关于 SELEX 技术的，而

上面这两位作者是这个技术的最早的发明人，并且一直在从事该领域的研究工作，所以他们

当之无愧的是这个领域的权威。 
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说明：由于相同技术不同作者的表述方式不一样，以上数据库收集的信息不全。这里希

望提醒读者，如果要进行分析，尽可能收集比较全的文献。 

不同作者发表的文章也可以按照例 1 中的方法进行输出，并进行作图统计分析。 

 

三、关键词分析 

关键词分析有利于了解一个数据库中的主要内容，并且可以利用上面的方法将关键词及

出现次数输出到一个文件中，供进一步分析。其它栏位的分析均可以参照上面的方法。 
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第九章 EndNote web功能简介 

EndNote web 是一个网络版的文献管理软件，使得我们可以随时随地使用。功能基于

EndNote 单机版，所以有很多功能只要熟悉 EndNote 的一看就会明白。这里结合单机版

EndNote 对 EndNote Web 仅作简要介绍。主要介绍如何注册、如何建立库文件以及如何利用

EndNote web 撰写论文。 

一、EndNote Web与单机版EndNote的比较 

下面的表格列举了 EndNote 的主要功能，并于 EndNote Web 进行了比较，可以看出

EndNote 单机版的功能远超过 EndNote Web。 

功能 EndNote Web EndNote 

保存文献 +  +  

组织和编辑文献 +  +  

储存文献数量  10,000 unlimited 

从多个数据库导入文献 +  +  

引用及编排参考文献 + + 

创建和保存高级搜索   + 

个性化显示设置   + 

编辑文献导入和输出格式   + 

支持习惯用语的自动输入   + 

引用表格 图片和方程式   + 

是否支持离线工作   + 

是否支持本地个人文件   + 

高性能桌面环境   + 
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二、EndNote web注册  

链接到 web of science 新的主页面，在窗口的上方有一个 my EndNote web,点击可以进入

到登陆界面。 

 

如果是登陆到旧的主界面，执行你想要的检索，即可在检索结果界面的右边看到登陆的界面，

如下图： 

 

 

点击 sign in to access endnote web,可以进入到登陆和设置界面。 
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登陆界面如下： 

 

输入已注册的用户名和密码，如果还没有注册，可以点击 register 进入到注册界面，如下图： 

 

根据提示输入相应的信息，点击确认即可。 

 

三、EndNote web的使用 

EndNote web 的功能很多地方与单机版的 EndNote 非常相似，所以读者可以将两者结合
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起来学习。利用 web EndNote 你可以将检索的结果储存在网上。登陆到 my endnote web 的

界面如下： 

 

上图实际上是 EndNote web 的主界面，左下显示的是 my endnote web 中的库文件，右

边显示的是文献的具体信息。 

下面我们按照 EndNote 中的顺序介绍一下 endnote web 的使用。同样从三个方面介绍：

建库、管理和使用。由于读者在学习这部分时已经有了单机版的基础，所以这里只作简单介

绍，未提及之处，请读者自行摸索。 

 

在 Endnote web 图标的下方有一排菜单，分别是：My references、 collect、 organize、 
format、 options 

 

My reference 相当于 EndNote 的主界面，这里会列出数据库中的文献信息。窗口的左边

会显示所有数据库的基本信息，包括创建的文件夹，以及每个文件夹中的文献数量。刚被加

入的文献会自动被放在 unfilled 的文件夹中。你可以创建新的文件夹，并将文献根据内容将

它们移动到相应的文件夹中。 

右边 all my references 界面，点击栏位标题，可以进行升序或降序排列。点击作者，可

以在数据库中进行该作者检索。点击文章标题，会列出文章的具体信息。点击 edit，会进入

到详细的文献信息编辑界面。可以进行任何栏位的编写，也可以添加注释。 

在左边的 quick search 栏，类似 EndNote 的 search 功能，可以快速对已建立的数据库进

行检索。 
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Collect 是联网检索工具，下面包含三个命令菜单：online search，New reference, Import 
references。 

其中 online search 可以对网上数据库进行检索，并将检索结果保存到 EndNote web 中的

文件夹中；New reference 与 EndNote 中的功能相同，手动输入一条文献记录；import references
可以将用文件形式保存的文献信息导入到 EndNote web 中，与 EndNote 中的功能相同，但在

EndNote web 中不能编辑 import filter，可能会导致部分文件导入不正确。 

关于手动输入文献和文献导入这里不作介绍，请读者自行摸索。仅简单介绍联网检索。

如果想联网进行检索，第一步需要选择联网检索的数据库，如下图： 

 

检索界面与 EndNote 的联网检索界面基本相同，但 EndNote web 不能增加检索栏位，

不能设置和储存检索策略。 

 

检索结果会显示在桌面上，可以选择下载部分文献并将其保存到 EndNote web 中。 
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Organize 

 

在 organize 界面除了可以对文件夹进行命名和删除等操作外，可以设置是否与他人共享。 

点击 share group，你可以在下面的界面输入多个 email 地址，从而实现与多人共享。 
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Format 

在 format 界面，可以将文章中插入的参考文献按特定的格式进行编排。包括引用的位

置和文章末尾位置的参考文献格式。 

首先在子菜单 Bibliography 下面选择相应的数据库，以及目标期刊。 

 

点击 format paper，选择需要 format 的文件，以及目标期刊，点击 format 即可。 

注意：如果没有安装 EndNote web 插件，可以点击下图右边 Cite While You Write Plug-in 插

件，下载安装。 

 

Options 

可以对登陆密码进行修改。 
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四、利用Endnote web编辑论文的参考文献 

利用 Endnote web 编辑参考文献，需要安装一个插件，安装完毕，打开 Word，你会发

现一个 EndNote Web 的快捷菜单条，如下图所示： 

 

对比一下 EndNote X1 单机版的工具条 

 

Endnote Web 由于无法管理附件，图片等，所以相应的功能也少一些。 

如果在你的电脑上同时安装了 EndNote 单机版和 EndNote Web，你可以通过菜单上的“工具”

－“模板和加载项（I）…”进行二者的切换。 

 

勾选 EndNote Cwyw.dot 或 EndNote Web Cwyw.dot，即可在两种模式下切换。 

 

如何插入参考文献，如何编排？ 

EndNote web 支持的插入方式比较单一，只能通过查找的方式插入。在网络通畅的情况
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第十章 EndnoteX1 常见问题及解决方案 

1、打开 EndNote 后，默认情况下给出一个对话框“Get Started in EndNoteX1”，让选择是

创建一个新的库还是打开原来的库等等，此对话框下面有一复选框：Do not display this 
message again.选中后不会再出现此对话框提示！如何恢复此对话框？ 

 

解决办法： 

开始-运行-regedit，打开 HKEY_CURRENT_USER/ Software/ ISI ResearchSoft/ EndNote/ 
Preferences,修改右侧项目 PrefsString(52)为 F，关闭注册表，重启电脑，打开 EndNote 时“Get 
Started in EndNoteX1”出现了！ 

2、如何将 CNKI 和维普的题录导入到 Endnote？ 

解决办法： 

方 法 一 ： 下 载 CvtCNKI 可 以 将 txt 文 件 转 换 为 Ris 格 式 （ 论 坛

http://biotech.ustc.edu.cn/forum/read.php?tid=821&page=1&toread=1http://biotech.ustc.edu.cn/fo
rum/read.php?tid=821&page=1&toread=1）。 

方法二：不需要转换直接将cnki和vip导入到EndNote中，需制作专门的filter，详细介绍

见http://biotech.ustc.edu.cn/forum/htm_data/8/0707/726.html 

3、web of science 输出的文献资料在 EndNote 中怎么没有摘要？ 

解决办法： 

输出的时候有个选项一个是 citations，一个是 citations and abstracts，输出时选上后面

一个就可以了，其他数据库与此相似。 

4、能否将本地硬盘已有的 PDF 文献批量导入 Endnote Library 中呢？ 

解决办法一： 
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目前没有简便的方法能够将本地文献批量导入到 Library 中，需要将文献的基本信息手

工输入到一个文本文件中，按照一种导入格式编排，例如按照 ISI 保存的文本格式编排，然

后使用 file-import –选择合适的 filter（例如 ISI-CE），将多条文献记录一次性批量导入到

EndNote 中。 

解决方法二： 

由于文献都是和某个主题相关的，首先从 EndNote 中联网检索包含所有文章的文献信

息。譬如，你有 120 篇全文都是关于减肥（weight loss）的，用 weight loss 到 web of science
和 PubMed 中检索，得到几千篇文献，全部下载到本地。再 EndNote 数据库中将文献按名称

排序，再打开放有 pdf 全文的文件夹，按名称排序，将全文直接拖到相应的文献记录下（这

里假设你的全文都是用文件名命名）。 

解决方法三： 

利用 Quosa 的自动识别 pdf 文献信息功能，将 pdf 文件中的基本文献信息识别出来，再

输出到 Endnote 中。详见 quosa 介绍部分。 

 

5、EndnoteX1 能否按导入时间对文章进行排序？ 

解决办法： 

打开 Endnote---Edit---preferences---Display fields，显示 Record Number，先导入的号码

小，后导入的号码大，根据号码大小即可排序。 

 

6、软件安装完成后，在 word（word2003）中没有出现 EndnoteX1 工具栏，如何解决？ 

解决办法： 

方法一：最简单，开始→程序→EndNote→“Configure EndNote”快捷选项，运行 Configure 
EndNote，勾选“Configure EndNote components for me”，选择下一步，勾选“Unified Cite While 
you Write for the Microsoft Word”(word2003)或者“Set Endnote as default reference manager for 
Word 2007”下一步完成。 

方 法 二 ： 开 始 → 运 行 →cmd→ 确 定 ， CD "C:\Program Files\EndNote 
X1\Product-Support\CWYW"，这里的路径视个人安装 EndNote X1 的目录而定，然后输入

regsvr32 "EndNote Cwyw.dll"。 

 

http://www.endnote.com/support/faqs/CWYW/faq45.asp#word2007 

word2003 与 2007 解决办法类似。 
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7、在 word 中出现宏问题提示，Endnote X 工具栏无法使用，怎么解决？ 

解决办法： 

可能是 Word 启动时，Endnote 的 CWYW（Cite While You Write，即写即引用）文件中

有一个未能正确的加载。在 Word 下，点击“工具/模版和加载项”，在“共用模版和加载项”
下你会看到两个 Endnote 文件。您看到的文件应该为：Endnote Cwyw.dot＆Endnote Web 
Cwyw.dot，只使用 Endnote 而不使用 Endnote Web 可以只选择第一项，反之亦然。 

如果需使用的文件未经校验，应当进行校验，然后点击“确定”。如果 Word 出现一个宏

安全警告，在“总是信任这一来源的宏”校验框中，点击“启用宏”，然后关闭 Word。重新打

开 Word 后，“工具”菜单下 Endnote 命令即可使用。 

如果问题还不能解决请先将EndNote X1（X 或 X1 应和前面统一）安装文件夹下的

Product-Support\CWYW 的 Endnote Cwyw.dot ＆ Endnote Web Cwyw.dot 件 拷贝 到

C:\Documents and Settings\用户名\Application Data\Microsoft\Word\STARTUP下，问题可解

决。

里 文

http://www.endnote.com/support/faqs/CWYW/faq4.asp 

 

8、EndNoteX1+office2003，正常使用一段时间后，打开 word，提示“指定的 word 库正在

使用，不能卸载”，卸载 EndNoteX1 再重新安装仍然是上述问题，重装 office，上述问

题依旧。重装系统该问题有时可以解决有时不可以解决。彻底卸载 X1，安装 X 一切正

常。 

 

解决办法： 

目前还不知道出现这种问题的原因，该问题出现的概率也很小，实践证明，通过以下设

置可以解决上述问题（可能不是最好的解决方案）： 

打开 word，工具---模板和加载项---添加 EndNote Cwyw.dot---打勾，注意，这个 EndNote 
Cwyw.dot 位置在 C:\Documents and Settings\Administrator\Application Data\EndNote 里面，添

加别的地方 EndNote Cwyw.dot 似乎无效。设置完后，关闭 word，再次打开 word，一切 ok。 

 

9、Word 中 Endnote 工具可以显示，但无法正常使用，点击 go to Endnote、insert selected 
citation 等均没反应，先打开 library 文件，再打开 word，症状依旧。 
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解决办法： 

很多人电脑里都安装了Snagit 7.0，和Endnote有冲突，能否不卸载Snagit而避免和

Endnote冲突呢？可以尝试以下方法：关闭Snagit，控制面板---添加删除程序---点击Snagit程
序---修改---点击下一步，在“word add-in”中，点击下拉箭头，选择“entire feature will be 
unavailable”，这样卸载了Snagit在word中的插件，word中EndNote工具栏就恢复正常了。（详

见http://www.endnote.com/support/faqs/CWYW/faq11.asp） 

 

10、我想在已有的参考文献格式上进行编辑，文后的序号形式是：1. 2. 3. 4.…… 我想改成：

[1] [2] [3] [4]…… 如何在 Endnote 中编辑？ 

解决办法： 

编辑一下你 output style 把 layout 的部分，插入 Bibliography Number，并在 Bibliography 
Number，前后加入[ ]，即：[Bibliography Number] ，然后重新使用这个 style format 一下你

的文献，就可以了。 

 

 

11、Endnote 的 numbered 格式为什么在文章中不是上标呢，怎么办？ 

解决办法： 

第一步：打开 EndNoteX1，Edit---output styles---“Edit numbered” 

第二步：Citations---Templates，选中[Bibliography Number],然后点击 A1，保存 

 

第三步，返回 word，先 Unformat Citations（按钮 ），重新 Format Bibliography，选

Numbered，确定 
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第四步，检查一下，即可发现 word 中引用文献的编号变成上标。 

修改此处 layout 的 hanging 值，可实现文后文献的第二行缩进，效果等同于问题 13 中

的修改方法。有关 style 设置可以参考本手册高级功能部分。 

 

12、将参考文献页码连接号改变一下，比如将 452－467 改成 452～467 这种格式的，如何

操作？ 

解决办法： 

需要在进行 style 的设置前，将 reference 下的 pages 项修改为以"～"连接的，可以使用

edit 命令下的"change text (ctrl+R)"，将 pages 中"—"该为"～"；然后再在 style 中仍使用 pages，
结果才会自动改为以“～”连接。 其实，在写完文章后使用替换，将“—”都替换成“～”更方

便 。 

 

13、写论文的时候怎么在 X1 中输出适合中国期刊的格式？ 

解决办法： 

第一步，下载cnki.ens（可以到http://biotech.ustc.edu.cn/forum/htm_data/8/0707/707.html下
载），下载后拷贝到EndNote安装目录下styles文件夹下。 

第二步，打开写好的文章，点击 format bibliography，选择 CNKI，如图所示： 

 

第三步：点击 layout，Hanging 设为 0.669，如图： 
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第四步：点击确定，可以看见输出格式基本符合中国期刊网杂志格式 

 

或者第三步中 Hanging 值不改，默认 1.270，返回 word，格式---段落---缩进—特殊格式

—悬挂缩进---确定，效果也可以，如图所示： 

 

说明，没有一个 style 能够完全满足你投稿的要求，要学会在 EndNote 中自己修改 output styles
的某些细节来满足杂志的不同要求。 
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14、在用 office 2003 和 EndNoteX1 写英文文章时，插入参考文献都会显示“references”，
但是当插入图表时。就会在英文文章中显示“表 1”、“图 1”，竟然是汉语，不知到底为

什么，如何解决？ 

解决办法： 

因为装的 office 是中文版的。参考文献由杂志样式决定，“图、表”这些字的名称由 word
决定，简单解决方法：安装英文版的 office，感觉不顺手的话可以在去掉域代码后利用字符

串替换。 

15、编辑 word 文章时突然出现了下列问题：在正文引用的地方可以正常的出现临时引用的

符号，比如{Moldobaca, 2005 #25}，当按 word 工具栏上的 format bibliography 按钮时，

在原临时引文的地方出现了一堆参数符号（乱码），比如 {ADDIN EN.CITE 
ndNote><Cite><Author>Moldobaca</Author><Year>2005</Year><RecNum>25</RecN
um><record><rec-number>25</rec-number><ref-type……也不再列出参考文献的目

录，而显示{ADDIN ENREFLIST}，这是出了什么问题？ 

解决办法： 

这是因为不小心改动了 Word 中的一些设置，打开 Word，点击工具---选项---视图，去

掉“域代码”前面的小勾即可解决上述问题。 

 

16、怎样把 Endnote 引文的杂志输出全称改为简称？ 

解决办法： 

方案一： Tools→Open term lists→Journal term lists→选中你需要的杂志→edit term→打

开对话框→填写 abbreviate 1，abb2，abb3；若 list 中没有你需要的杂志，可以自己手动

添加→new term。 

方案二：EndnoteX1 默认提供了 12 个学科的常见杂志名称简写，存放在安装目录下的

Terms Lists 文件夹，直接导入（Tools→Define term lists→Journal term lists→选择 list 栏
目>>>选中 Journal list>>>Import list）即可。 

第一步，启动 Endnote，Tools---Open Term Lists---Journals Term Lists---Lists---Journals 
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这时候右边第一个你可以 Create List，选择右边 Import List，到安装目录下的 Terms Lists 

 

进入后会看到很多不同专业类别的 Txt 文档，有化学的、医学的等，你可以根据需要导

入即可。 

第二步，导入后，在 Endnote 里选择 Edit，假如你现在选定输出格式为“Numbered”，你

可以在Edit里选择Output Styles---Edit “Numbered”，在 Journal Names里可以选择 Journal 
Name Format 几种不同的格式如图所示 

 

说明，在 Endnote 的 Term Lists 的杂志名称个别没有，这时你可以到官方网站下载最新

的导入或者等文章修改完去掉域代码后对个别的进行手工修改。 

方案三：网上(QQ 群：19233101)找到一个 6000 多个杂志的 list。所以一般不需要自己

输入了。杂志 list 导入：Tools→Define term lists→Journal term lists→选择 list 栏目>>>
选中 Journal list>>>Import list>>>导入文件。需要注意的是，不同的 library 需要各自导

入一次。如果引用之后，某一个杂志还没有出现简写，可能是 list 中有一些重复（导入

的新 list 和默认的 list），查看 Journal list，修改该杂志即可。 

 

17、Endnote 中英文混排的问题，中文用“等”，而英文用“et al”，这个问题如何解决？ 

解决办法： 

文 章 修 改 完 后 手 动 修 改 ； 或 者 使 用 宏 解 决 ， 详 细 方 法 见

http://emuch.net/bbs/viewthread.php?tid=304723&fpage=7 
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18、使用 EndNote 时，在不同段落引用同一参考文献时，如何消除重复的参考文献？ 

解决办法： 

请点击 Edit→Preferences→Formatting→选择 Merge duplicates in bibliography。如果希望

保留重复的参考文献，请不要勾选此项。 

 

 

19、对于 EndNote 来说，在 word 中引用几篇还可以，一多的话，到后来引一篇，都要在

word 上停留很长时间，请问如何解决？ 

解决办法： 

打开 word，在 EndNote 工具条上点击 Format Bibliography----点击 Instant Formating，设

置为 turn off ，然后确定。如下图所示： 

 

20、如何取消打开 Word 时同时打开 Endnote？ 

解决办法： 

打开 Word，点击 （即 Cite While You Write Preferences 按钮）---General---去掉 Open 

Endnote when start word 前面的勾。 
 

21、使用 Endnote 时出现了“Service Error: Generic”的错误信息，如何解决？ 

解决办法： 

针对不同情况 EndNote 网站有不同的解答： 

http://www.endnote.com/support/faqs/enfaq22.asp#libone 

22、Endnote 库文件损坏的恢复办法。有些人在使用 Endnote 文献管理软件过程中，*.enl 文
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件突然不见了或者文件打不开，如何恢复*.enl 文件？ 

解决办法： 

库文件损坏有两种情况： 

 一是.enl 文件依然存在，一般利用软件本身自带的 recovery 可以恢复； 
 二是库文件.enl 丢失，.data 文件夹中的信息依然存在，这种情况下可以采取下面的

方法解决：在原先 enl 文件位置新建一个任意格式文件，将文件名命名为"库名.enl"(注
意要将扩展名改为 enl)，然后双击该文件即可打开数据库正常使用。数据库信息做过

改动后，会自行保存为 endnote 默认的数据格式，使用者无需担心。 

23、PDF 的链接丢失怎么办？打开 PDF 链接是出现如下提示： 

 

回到“Data”文件夹下的 PDF 文件夹找到相应的文件后，PDF 图标显示正确，双击打不开，

右键---open with acrobat，打不开；右键---打开方式---Acrobat，依然打不开。或者复制

Endnote 数据库时提示创建文件出错；或者压缩解压缩 EndNote 数据库时会提示创建文件

错误。 

解决办法： 

这些都是因为文件路径名太长造成的，Windows 允许使用的最大文件路径为 260 字符。

PDF 文档在 EndNote 里的存储方式为 Endnote library\“数据库名”.data\PDF\“PDF 文件名”+10
位数 Endnote 内部索引号\“PDF 文件名”.PDF，非 PDF 文件名部分占去约 50-60 字符，因此

单个 PDF 文件名的长度建议不超过 100 字符（计空格），否则容易出现上述错误。 

 

24、任何一个教程也不能涵盖所有问题，在 Endnote 使用过程中遇到问题怎么办？ 

（1）看中英文教程，英文教程软件自带，无需下载。 

（2）上论坛交流和 qq 群交流，推荐以下论坛： 

a：http://biotech.ustc.edu.cn/forum/thread.php?fid-8.html 

b：http://emuch.net/bbs/index.php?sid=mNFsAf，在小木虫里注册一个号，进学术软件里交流 

c：qq 群 19233101；26904157 等 

（3）看视频教程，常用的网站 

http://140.112.113.4/vtour/endnote/index.htm 

http://www.csis.com.tw/training_EN2.asp 

（4）以下这些常用的网站有时候可以帮助你解决一些问题 
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a：The EndNote-Interest Mailing List 兴趣组 

http://www.endnote.com/support/en-interest.asp 

b：精华 Archive 

http://lists.adeptscience.co.uk/endnote/ 

c：Filter 更新 

http://www.endnote.com/support/enfilters.asp 

d：Styles 更新 

http://www.endnote.com/support/enstyles.asp 

e：Connection 更新 

http://www.endnote.com/support/enconnections.asp 

f：FAQ（Frequently Asked Questions）常见问题： 

http://www.endnote.com/support/faqs/index.asp 
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第十一章 RefViz简介 

RefViz 是由 Thomson 公司和 ominiviz 公司合作开发用于文献信息分析的软件。网络可

以帮助我们获取大量的信息，当信息多到一定的程度的时候，我们不可能逐一阅读；另外，

即使文献的数量不是太多，可以阅读，也会耗费大量的时间，同时也会大幅降低我们获取信

息的效率。怎样从这些信息中快速找到相关的信息，怎样快速把握这些信息的主要内容，是

当今每位科研工作者都面临的问题。 

RefViz 可以帮助我们分析、组织和管理大量的文献。通过采取与我们阅读文献类似的

方式：通读所有文献、找出关键信息，然后进行归类，并以可视化的图形方式将归类的结果

展示出来。可以帮助我们发现研究热点，找出文献间的相互关系，快速了解某一领域的整体

情况等。因此该软件可以帮助我们确定研究方向，开拓研究思路，寻找新的解决方案和突破

口等。因此，不管你是初涉科研的学生还是一位资深的研究人员，我都建议你去学习和掌握

这款软件。它可以帮助你快速处理海量信息，让你在竞争中领先一步。 

这一章中主要介绍以下内容，让大家对软件的基本功能有一个大致的了解。 

 软件基本功能示例 

 RefViz 工作原理 

 软件架构 三种来源的数据分析 

 安装运行 

 主界面简介 

 Endnote 中数据库的分析 

 利用 RefViz 分析发展趋势 

 

一、软件基本功能示例 

下面通过对 2006 年 nature 发表论文的分析为例来介绍一下这个软件： 

通过Endnote联网下载nature系列杂志 06 年已发表的研究论文，通过RefViz进行分析，

2006 年共有 4083 篇文献（这里剔除了没有摘要的文献），文献被分为 63 组（右下角total 
group），左上图代表 63 组文献的分布，红色方框选择的文献共有 2123 篇，这表明这 12 组

中，文献的数量超过总数的一半，说明这是关注较多的研究方向。右边的列表中显示了这些

文献中的主要关键词1，可以看出都是关于生命科学研究的，而且主要集中于receptor, cancer, 
RNA, 以及tumor等方面的研究。这样通过选择全部文献以及不同区域的文献，观察关键词

的变化，可以了解到这些文献的大致内容。 

                                                   
1 这里所指的关键词是RefViz经过分析后得出的重要词汇，不是文献本身给出的关键词，书中部分地方用

主词来区分，而有些地方直接用关键词，请读者注意。 
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图 11-1 RefViz 分类图 

用同样的方法对 07 年发表的文章进行分析，可以看出 07 年的研究热点和趋势。 

对于有较多经验的研究人员来说，有多种途径可以获得当前研究热点的信息，如会议、

交流、论文等。对于初涉研究的学生来说，只能通过综述文献和书籍等方式来获取信息，或

者直接追踪最新文献，这种方式需要较长时间的积累并消耗大量的时间。如果通过软件可以

很快了解到这些信息。 

 

二、RefViz工作原理 

RefViz 处理文献的方式与我们平时阅读文献的过程类似。我们平时处理文献的方式是：

把一类文献全部找来，逐一阅读文章标题以及摘要，然后根据主题内容的不同分成若干类。

RefViz 处理一批文献时，也是通过 reading-finding-dividing 的过程。RefViz 首先通过阅读文

章的标题和摘要，与其它的软件不同，RefViz 并不是单纯通过词频来统计，而是通过一种

数学模式找出哪些词是最重要的，哪些是次重要的，哪些是无关紧要的。然后利用这些最重

要的词和次重要的词对每篇文章进行标识，再通过标准的聚类方法将这批文献分成若干组

（group）。RefViz 分组后并不像我们日常那样将每组文献再建一个文件夹，而是通过图示的

方式将这些组的文献根据相互间的关系呈现出来。如图 1-2 所示，每个文件夹图标表示一组

文献，每组文献之间根据相互的类似程度进行排列。图标的大小代表文章数的多少，分布的

位置靠得越近，内容越相似。从下图还可以看出，左边的文件夹比较密集，说明这些方面的

文献较多，是这批文献中研究的热点方向。如果我们通过传统的方法建立多个文件夹，不通

过详细阅读文件夹的内容是无法发现相互间的关系的，甚至连每个文件夹中文献的数量也得

打开文件夹才能知道。 
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图 11-2 galaxy 图示 

RefViz 根据文章的内容快速将一大批文献分成若干亚类，并且将每组文献根据主要的

关键词汇作上标示，就像我们把每一叠文献写上标签一样。在上图中当鼠标经过每个文件夹

的上方，都会显示出一个浮动窗口，这种方式便于我们快速了解其中的内容，如下图所示。 

 

图 11-3  pop-up 浮动窗口 

当一批文献经 RefViz 分类完成之后，还可以通过一系列工具去影响它的分类，如通过

调整 major topic，或者定义同义词（thesaurus）等，可是实现交互式的分类。也可以通过辅

助工具找出某些概念之间的相互关系，以及与某篇文章相关的其它文献等。 
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三、软件架构  

根据个人理解，整个软件可以用下图来展示，三种不同途径来源的文献信息，经过 RefViz
分析后，以两种直观的图示方式展现出来，我们可以从这两种图示方式中获得信息，也可以

通过一系列的辅助工具影响 RefViz 的分类工作。 

 

图 11-4 RefViz 软件架构 

可供 RefViz 进行分析的文献信息有三条途径的来源，一是通过 RefViz 直接联网检索；

二是对文献管理软件已经建立的数据库进行分析；三是通过一些预存的文本文献信息或通过

格式转换过来的文献信息。 

RefViz 分析的结果有两种展示方式，上面提到的 Galaxy 视图和 Matrix 视图如下图所示。

关于两种图示的详细内容后面将会专列章节介绍。 

 

图 11-5 matrix 视图 
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四、安装运行 

RefViz 的安装运行比较简单，从网站（http://www.RefViz.com）下载试用版，或购买正

式版，点击 RVINSTALL.EXE 即可进行安装。第一次运行会提醒你输入序列号。 

五、主界面简介 

第一次运行软件，程序会自动打开 sampleview 的文件，如下图所示。下图中，程序的

主界面主要分成四部分，1 是显示分析结果的窗口，有两种视图显示方式，当前显示的是

Galaxy 视图。2 是 topic 区域，可以看到这里共有三栏，左边的是 major topic，中间的是 minor 
topic，这两栏中的词是 RefViz 用来对文献进行分类的依据，最右边的是 descriptive terms，
不影响 RefViz 的分类。3 是当前选择的所有文献列表，4 是软件的提示区域，告诉你当前

界面的一些信息，以帮助大家理解和学习。 

 

图 11-6 main view 界面 

六、Endnote中数据库的分析 

下面以 Endnote 中的一个数据库为例，直观地展示一下 RefViz 分析的过程。如果你已

经安装了 Endnote 和 RefViz，在 Endnote 程序主界面，点击 tools-data visualization，如下图： 
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图 11-7  利用 RefViz 分析 Endnote 中的数据库 

软件会自动打开 RefViz，并对当前文献数据库的所有文献进行分析，在处理过程中会

出现一系列处理进程窗口，如 

 

 

 

图 11-8 数据库分析进程窗口 
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处理完毕，RefViz 将结果以 Galaxy 视图方式展现出来。如下图： 

 
图 11-9 RefViz 分析结果视图 

我们可以通过两种视图以及 topic tool、search tool 以及 reference viewer 来了解文献的详

细信息。具体分析方式见后面章节的介绍。 

七、利用RefViz分析发展趋势 

下面以一个实例分析某一领域的发展趋势。首先检索有关 SELEX 的文献并利用 RefViz
创建视图进行分析。分别检索 2006、2007 年以及所有文献的分布情况，结果如下图： 

 

2006 年文献分布                      2007 年文献分布 

 

1992-2006 年文献分布                      1992-2007 文献分布 

图 11-10 发展趋势分析视图 
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由上图中可以看出，红色椭圆选中的区域是 2007 年明显占优势的区域，2007 年在该领

域发表的文章远远超过了 1992-2006 年文章的总和。分别查看红色框中的主题词分布和所有

文献的主题词分布，如下图所示： 

  

图 11-11 左边为 2007 年主词分布，右图为所有文献中的主词分布 

比较排列在前面的主词，可以发现 2007 年排在 1、2 位的主词在所有文献中分列 3、1
位，变化不大；2007 年排在 3、4 位的主词，在所有文献中列在 11、12 位，有较大提前；

比较明显的变化是 2007 年排在第五位的 detection，在所有主词中排在很靠后的位置；这表

明 detection 是 2007 年这些文献中的一个热点。进一步查看文献信息发现 2007 年发表的文

章中有相当大的一部分是关于检测（detection）的。 

可以通过以下途径验证以上判断，分别检索 2007 年发表的文章共 181 篇，所有关于

detection 的文章 81 篇，包含 detection 或 2007 年发表的文章共计 215 篇，由此可以得出 2007
年发表的关于 detection 的文章有 181+81-215=47 篇，占 47/81=58%，即关于 detection 的文

章 2007 年发表的文章占总 detection 文章数的 58%。 

所以通过以上途径，我们可以很快把握科学发展的动向。知道哪些是当前比较热门的方

向，从而为自己确定研究方向服务。 
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第十二章 界面及菜单 

 

这章主要介绍软件界面及基本操作，主要包括以下内容： 

 主界面 

 快捷菜单及鼠标快捷键 

 File 菜单 

 Edit 菜单 

 Visualizations 菜单 

 Tools 菜单 

 Help 菜单 

一、主界面 

打开 RefViz 时，我们会看到如下的界面： 

 

1. RefViz 分析结果的显示窗口，图中每个文件夹图标 （象一张纸）表示一组文献，

每个点表示一篇文献。如果鼠标移到每个文件夹上方，会显示一个浮动窗口，显示

该文件夹的序号，文献数目以及本组文献讨论的主要关键词。文件夹的大小代表了

该组中文献数量。如果鼠标停留在某一篇文献的上方，浮动窗口会显示出这篇文献

的标题以及所属 group 的号码。 
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2. Topic 包含 RefViz 用于分类的 major topic 和 minor topic，以及 descriptive terms。
RefViz 依据 major topic，minor topic 进行分类。我们也可以通过调整 major/minor 
topic 影响 RefViz 的分类。 

3. Reference viewer 文献信息显示窗口。可以在这里列出所有被选中的文献信息，并

且可以象在 Endnote 中一样，通过点击各个栏位进行排序。双击每条文献会在新的

窗口中打开这条记录的详细信息； 

4. Advisor 适合初学者了解软件功能，可以通过快捷菜单 7 中的最后一个按钮关闭；。 

5. 当前打开视图文件的名称； 

6. 软件菜单条； 

7. 常用命令的快捷键； 

8. Quick search 

用于快速检索。在检索框中输入待检索词汇，点击 GO 即可。对一般词汇，不能限

定在特定栏位检索，只要文献中包含检索的词汇，这些文献都会被显示出来。 

Quick search 不同于 serach tool 工具，不能使用 NOT 或 OR，如果检索多个词汇，

软件自动认为相互间用 AND 连接，如果需要检索词组，需要将关键词用双引号“”标

注。如果输入的是 1900 到 2040 之间的 4 位数字，软件会默认在年代栏位检索。 

无论是通过组合检索还是单个词汇检索，主界面的信息都会发生相应的变化。你可

以观察到 galaxy 某些文献被高亮显示，在 reference viewer 栏位只显示查找结果的文献，

topic 区域的词汇也会发生相应变化。如果双击 reference viewer 中的某一篇文献，该文

献将在新打开的窗口中，并且我们会发现检索词被软件自动用亮绿色标示出来，而它的

同义词则以另一种颜色标示。 

9. 分别点击 Galaxy 和 matrix 两个按钮，可以在两种视图方式间切换。 

Galaxy 显示的是所有文献分类的结果， 表示的是一组文献，单个的小点表示的

是具体某一篇文献。图标的大小表示文献数目的多少，图标间相对位置表示了每组文献

间的关系。如果两个组比较靠近，说明它们讨论的内容有相似之处。在每组文献中，如

果每篇文献讨论的内容比较集中，这些文献对应的点分布也会比较集中；如果某些文献

除了与这组相关，还与另一组文献相关，这篇文献就会趋向在两组中间的位置分布。也

可以通过 和 来关注某一局部的信息。 

Matrix 显示的是 group 和 major topic 之间的关系，或者显示 major topic 相互间的关

系。每行显示的是每组中三个 major topic，每列显示的是用于区别每组文献的 major 
topic。方格中的颜色代表了 major topic 与 group 的 相关性。红色表示正相关，蓝色表示

两者没有相关性。 
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在 matrix 窗口的下方，有三个选择框，Color by：Relevance，表示图中的颜色代表

相关性，靠近选择框的颜色条表示不同颜色所代表的含义；如果此选择框中选择 counts， 
方框中的颜色将代表文献数量的多少； Order：Alphabetical 表示 major topic 和 group
均按字母顺序进行排序；如果选择 similarity将按相似性进行排列，你会发现类似的major 
topic 将排在一起，这将有利于我们快速找出文献之间的相互关系。Rows：groups，表

示行代表的是 group，可以选择 major topics，那样每行将代表 major topic，此时可以用

于快速浏览 major topic 之间的相互关系。 

 

10. Topic 和 search tool 切换窗口 

Topic 显示当前所选文献中的 topic 信息，如果改变选中的文献，将会发现 topic 的

内容也会发生相应的变化。通过 topic 中的内容可以知道所选择文献的大致内容。Major 
topic 决定了 group 的分类，minor topic 的重要性要小于 major topic，会对分类产生一定

的影响。Descriptive term 往往是由于出现过于频繁或出现极少，无法用于分类。 

点击 search 可以进入到 search tool 界面，如下图所示： 
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这个检索界面除了用来查找文献之外，在 RefViz 中，它更是一个帮助我们发现文

献间相互关系的工具，是帮我们有效理解一批文献的重要工具。在 galaxy 视图和 matrix
视图中都为我们发现文献的主旨及相互间关系提供了不同的途径。Search tool 可以配合

galaxy 视图和 topic 用于快速了解大量文献中的相关内容。与 quick search 所不同的是，

我们可以在 search tool 中将搜索限定在特定的栏位。 

在检索窗口输入关键词，点击 search，与此关键词相关的文献在 galaxy 窗口会被高

亮显示，同时所有文献会在 reference viewer 窗口一一列举出来，topic 窗口会将这些文

献中的 major topic 以及 minor topic 一一列举出来。通过 topic 可以大致了解这些文献的

内容，通过这些文献在 galaxy 窗口中的分布，可以知道这些文献与其它文献间的相互

关系。 

如果你知道某一篇文献是你非常感兴趣的，通过 search tool 找到这篇文献，这篇文

献所在的 group 中的其它文献可能也具有较高的参考价值。 

此外，你还可以检索每年发表的文章在 galaxy 视图中的分布，来了解该领域的发

展趋势。也可以查找某个作者发表的文章在视图中的分布，以此来发现该作者的研究兴

趣所在，或者该作研究内容与你研究课题之间的关系。 

 

11. Promote、demote、reprocess 

Promote、demote 以及 reprocess 可用于调整 major topic，可以通过 demote 将 major 
topic 中的不重要的词降级为 minor topic 甚至 descriptive term，也可以通过 promote 将

minor topic 升级为 major topic。调整完毕，点击 reprocess 进行重新分类处理。当你对 topic
进行调整后， topic 窗口上方会以红色字体显示 topics tool frozen-change pending. 
Reprocess or reset.此时如果你选择其它文献或 group，topic 栏位将保持不变，直到你选

择 reset 放弃前面的 topic 修改或者用 reprocess 进行重新分类。 

有时候调整 topic 并不一定会引起视图的明显变化，例如，将一个比较普遍出现的

一个描述性词汇升级为主词，可能对视图没什么影响。如果将主词降级可能会对视图产

生较为明显的影响。 

定义同义词有时候对 Galaxy 视图也没有明显，如果定义的同义词是主词，可能会

对视图会产生一定的影响。 

12. 12 和 13 是一个状态栏，分别表示选中的文献数/总的文献数，选中的 group/总的

group。 

二、快捷菜单及鼠标快捷键 

    快捷键代表的具体功能见下表。 

 

 

 116



文献管理与文献信息分析 罗昭锋 韩敏义等编著     版本 1.00 

图标 名称 功能及菜单中对应的命令 

New View 新建一个视图 (File -> New View…)  

Open View 打开视图或管理视图(File -> Open/Manage Views…)  

Select Cursor 选择单篇文献或选择一组文献，如果按住鼠标左键可

以选择一个区域 
 

 Pan Cursor 移动视图 

快捷键: 按住鼠标中间键光标即可变成这种图标 

 Zoom Cursor 可以对视图进行放大或缩小，选择后按下左键上下移

动即可放大或缩小。快捷键: 按下右键可代替这个快

捷键 

Magnify 
Cursor 

在 Galaxy™ 或 Matrix™视图模式下，将选择的区域

放大 
 

Reset 在 Galaxy™ 或 Matrix™视图模式下，返回到初始状

态 
 

Show/Hide 
References 

在 Galaxy™视图模式下，隐藏单篇文献对应的点  

 Show/Hide  

Groups icons 

在 Galaxy™视图模式下，隐藏一组文献对应的图标 

 Export to 
Bibliography 
Manager 

将选择的文献输出到文献管理软件，这需要在 Edit -> 
Preferences… 中设置 Risweb32.exe 的位置，此快捷

键相当于(File -> Send References to -> Bibliography 
Manager) 

Thesaurus 显示词典窗口，(Tools -> Thesaurus).该功能主要用于

定义同义词 
 

Help 显示帮助文件，可以按 F1 激活 

(Help -> RefViz Context-Sensitive Help) 
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 Show/Hide 
Advisor 

显示或隐藏  Advisor，可以用  F2 激活  Advisor。 
(Tools -> Show Advisor or Tools -> Hide Advisor) 

 

快捷键命令一览表 

 

Action Keyboard Equivalent 

New View… /新建视图 CTRL+N 

Open/Manage Views…/管理视图 CTRL+O 

Copy /拷贝 CTRL+C 

Cut /剪切 CTRL+X 

Paste /粘贴 CTRL+V 

Select All References /选择所有 CTRL+A 

Undo last selection /撤销最后一次操作 CTRL+Z 

Clear all selections /清除所有选择 Delete (Del) 

Find in Reference Viewer Preview Pane/在文献窗口查

找 
CTRL+F 

Select References Highlighted in Reference Viewer/选择

高亮标记的文献 
CTRL+S 

Deselect References Highlighted in Reference Viewer/不
选高亮标记的文献 

CTRL+D 

Context-sensitive Help /显示基于网络的帮助文件 F1 
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Show/Hide Advisor/显示隐藏当前内容的帮助 F2 

Execute (Go, Search, OK, or other default button)/执行 Enter (or Return) 

 

三、File菜单 

 

• New View 意为创建一个新的视图 

 

可以通过检索网上数据库或者利用参考文献文件创建视图。 

• Create Subset View 

通过 RefViz 对一批文献进行分析，可能发现其中只有一部分与特定目标相关，对这部

分文献再进行分析，有助于我们深入理解特定主题的相关信息。 

首先选择感兴趣的文献，依次点击 File -> Create Subset View…，RefViz 可以对这部分

文献进行分析。可在弹出的窗口中对新的视图进行命名。 
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• Open, Rename, or Delete a View 

通过 File -> Open/Manage Views… or press CTRL + O.打开下面窗口： 

 

选择文件，此时可对该文件进行开启、重命名或删除操作。 

• Share Views 

Import shared views 

可以打开之前已经创建的.xpt 文件，不管这个文件是在 wondows 操作系统还是在 Mac
系统下创建的均可以打开。 

Export view for sharing 

已经创建的视图可以输出成 xpt 文件与他人共享，而无需重复分析。选择 File -> Export 
View for Sharing，进入如下界面：  
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上图中可以看出，所有相关的视图都会列举出来，可以选择需要共享的视图，默认设置

为全部选中。 

• Export References or Send References to Other Applications 

选择 File -> Export References…，将选中的文献默认输出成文本格式文件。如果没有选

择任何文献，此命令将不可执行。 

通过 File -> Send References to -> Bibliography Manager 可以将选中的文献输出到文献管

理软件中。执行此命名，在本机上已经安装的文献管理软件就会打开，并要求你选择输出的

目标文献数据库文件名。 

• Save Images of Visualizations 

将当前窗口保存为图片的形式。在 RefViz 主界面，当前窗口会以浅蓝色的方框标示出

来。随着当前窗口的不同，该命令会依次变为 save galaxy image-save matix image-save topic 
image-save reference viewer image。该命令可以通过 ctrl+P 实现。 

如果当前选择窗口是 galaxy，按下 ctrl+P 会弹出如下界面： 
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可以通过左上角的 file 菜单选择保存或打印该图。 

• Exit RefViz  

点击退出 RefViz 程序，或者点击右上角的 X 按钮关闭程序。 

 

四、Edit菜单 

 

Edit 菜单下的前几个命名都很简单，Edit -> Select All 或者用 CTRL + A；取消最后的

选择 Undo Last Selection 或用 CTRL + Z；清除选择用 Clear Selections 或按 Delete，也可以

在 Galaxy™视图下点击空白区域。 

选择 reference viewer 窗口某些文献，先在该窗口标记这些文献，然后 Edit -> Select 
Highlighted References 或者用 CTRL + S，取消选择用 Edit -> Deselect Highlighted References 
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或用 CTRL + D。 

Customize Preferences 

在 Edit -> Preferences…子菜单窗口，可以进行下列设置： 

1. 设置 galaxy 视图的背景和图标颜色； 

2. 设置帮助文件的浏览器和文献管理软件信息； 

3. 可以对 reference viewer 窗口进行设置； 

4. 视图创建选项进行设置，主要是创建视图时是否排除不包含摘要的文献； 

5. 对联网检索数据库进行设置； 

6. 以上功能分别如下图所示： 

 

Galaxy 视图颜色设置 

    用户可以根据自己的喜好设置不同的颜色，包括背景色，图标颜色，选中与未选中图标

的颜色等。 

 

 

Helper applications 设置 
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上图中将在线帮助文件的浏览器设置为 myie.exe。并设置了 RISWeb.exe 的位置，此设

置是将 RefViz 中的文献输出到文献管理软件的必要条件。 

Reference viewer 设置 

 

文献预览窗口设置，在 reference viewer 窗口，双击某一篇文献，这篇文献将在另一个

窗口中打开。以上这些设定的意义分别是：No more than 32K characters ，表示对于很大的
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文献只显示前 32k 字符的信息，有利于加快处理速度。也可以选择 full reference content，显

示所有大小的文献。 

View full reference (double-click in Viewer)下的 single window 表示只打开一个文献预览

窗口，如果打开新的文献，前一篇文献的窗口自动关闭；选择 new window 表示每次打开一

篇文献均新开一个窗口，有利于多篇文献的比较。 

View creation 

View creation 界面主要包含两个设置，一是设置在进行分析时是否对不包含摘要的文献

进行分析；二是每次开启时是否提示新建视图。对于第一个设置，一般是勾选 Exclude 
references with no Abstract，因为没有摘要的文献信息量太少，影响分类的准确性。但是，如

果通常分析的文献很多都是没有摘要的文献，譬如书籍，如果勾选此项根本无法分析。第二

个设置一般不选，这样软件会自动打开最后使用过的视图。 

Reference retriever 设置 

可以对联网检索数据库进行设置。通过 RefViz 进行联网检索前，需要对数据库进行设

置。如果在下图界面选择了多个数据库，RefViz 就可以同时对多个数据库进行检索。 

当 RefViz 同时进行多个数据库进行检索时，不可避免会出现很多重复的文献，对于重

复的文献 RefViz 只保留一份，将其余的删除。保留哪个数据库来源的资料，取决于下图中

数据库的排列顺序。数据库的位置可以通过数据库选项右边的上下箭头调整。 

可以通过 test all checked 检查所选数据库是否可用。 

关于添加网络资源的设置，请直接参考软件英文说明书《RefViz users manual》。 
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五、Visualizations菜单 

 

可以通过这两个命令来切换视图，但最方便的方式是直接点击主界面的 galaxy 和 matrix
快捷键。 
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六、Tools菜单 

 

前面三个菜单 topics、search 和 reference viewer 可以在三个窗口间切换当前窗口。 

Thesaurus 用来定义同义词，点击进入如下界面： 
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Show or Hide the Reference Viewer Preview Pane，是否在主界面显示文献的预览窗口。 

Show/hide Find in Preview Pane 是否在主界面显示文字查找窗口。 

Hide or Show the Toolbar 显示或隐藏快捷工具条 

Hide or Show the Advisor 显示或隐藏 advisor 

Choose Fields in Reference Viewer 

点击进入如下界面，可以设置在主界面显示文献的栏位信息。 

 

七、Help菜单 

 

按下 F1 软件会自动打开网络浏览器，并查找 RefViz 网站上的帮助文件。 
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第十三章 文献信息分析 

导读  本章帮助大家进一步熟悉 RefViz，详细介绍了各视图及辅助工具的功能，在本章

的结尾处还给出了一些示例来说明如何利用 RefViz 解决日常碰到的文献信息问题。具体

内容包括：  

1. 三种来源文献的分析及视图创建过程 

2. Galaxy 视图 

3. Matrix 视图 

4. Topics tool 

5. 搜索工具  

6. 同义词 stop word，others term 

7. 将文献输出到文献管理软件  

8. 应用示例 文献信息分析 

一、三种来源文献的分析及视图创建过程 

可以直接用于 RefViz 进行分析的信息来源有三种，一是直接联网检索的数据库，二是

文献管理软件（Endnote，RefViz，Procite）建立的数据库，三是通过转换得到的文献信息文

件。 

（一）执行联网检索 

选择 File-new view，在 create new view 子窗口选择 searching database(s) using reference 
retriever 
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在上面检索窗口输入检索关键词，点击下方 search 即可开始检索。也可以通过 add/edit 
data sources 来调整检索的数据库，实现多个数据库同时检索。 

检索完成后结果会显示出来，如下图： 

 

如果上图中返回的文献信息超过 32000 条，需要删除部分数据库，或限制检索年代，或

精炼检索条件等，使总的文献数少于 32000 篇；如果少于 5 条，也是不能用软件进行分析的，

需要用宽松的条件检索，并确认数据库设置正确。如果对检索到的信息满意，在 view name
中输入视图名，点击 retriever 开始下载检索到的文献。文献下载后，会自动去除没有标题的，

自动移除没有摘要的文献（这是默认设置，也可以在 View Creation Preferences 中修改）。 

检索数据的预处理 

如果检索到的文献有很多是重复的，软件将根据资料来源顺序自动保留一份。数据库的

检索顺序可以进行调整。不同的数据库相同的文献也可能包含不同的信息，如 web of science
来源的文献有引用信息，如果你希望保留引用信息，就应将 web of science 放在数据库列表

的前面。有些数据库可能会截去长文摘，如果你希望保留长文摘，你需要把保留长文摘的数

据库放在前面。 

检索结果下载后，RefViz 会自动对下载的文献进行分析，并给出分析结果。通过 galaxy
视图和 matrix 视图，结合几个辅助工具就可以了解全面的信息了。 

RefViz 会根据你选择的数据库资源，同时在多个数据库中进行检索。检索到的文献数

量，会首先呈现给你，根据你的选择下载相应的文献，并自动去重复，自动创建视图。 

各个数据库提供的检索方案不同，即使相同的条件，被处理和被检索的栏位都可能有差

别，这方面请参见各网站检索说明。 

对于词组检索，需要使用双引号进行标识。如果不用引号，词与词之间，RefViz 自动

以 AND 处理。 

有些网站可以使用通配符(?)和(*)。 
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（二）直接分析文献管理软件中的数据库 

如果已经安装了文献管理软件 Endnote 7 以后的版本，或者 Reference Manager 11 以后

的版本，可以直接在文献管理软件下进行操作，一步完成分析。在 Endnote 中 tools 下有一

个 data visualization 的选项（可参考第十一章的图 11-7），在 Reference Manager 下的 reference
菜单下，点击可以自动调用 RefViz 对当前数据库进行分析。根据在 edit-preference 中的 view 
creation 设置不同，可能会自动保留或滤除信息不全的文献。分析过程根据数据库大小不同

需要的时间也有差别，分析完成，RefViz 显示分析结果。通过 galaxy 视图和 matrix 视图，

结合几个辅助工具就可以了解文献的全面信息了。 

 

（三）利用文件进行分析 

这里所指的文件也是包含不同文献信息的文件，而且包含一定的格式。在 RefViz 界面，

选择 file-new view，在弹出窗口选择 Using reference file(s)，选择已经预存的文件， 

 

选择上述选项，根据提示即可创建相应文件的视图。 

 

重复的处理 

RefViz 可以识别来自同一文献文件中的重复信息，但来源于不同文件中的重复信息，

RefViz 不能自动识别并删除。如果 RefViz 已创建视图的数据中包含有重复的文献，只能通

过手工去除。在 Galaxy 视图中，选择所有文献，在 reference viewer 中用标题排序，挑出重

复的文献，选择 Edit-> Deselect Highlighted References 或按 CTRL + D，然后 File -> Create 
Subset View…就可以把没有重复的文献重新创建视图了。 

直接联网检索，然后进行分析是非常方便的方法。如果这条途径行不通的话，我们也可

以把各网站的检索结果下载为文件，然后，再对文件进行分析。 

从不同数据库下载文献并保存到一个文件中，请参考英文说明书。 

 

（四）视图创建的过程 

1.词库的创建  

首先创建包含所有栏位的词库，移除终止词，进一步创建词库索引用于 Search tool 检
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索；终止词包括“about，either，also，very，who，these”等，这些词出现非常频繁，对信

息分析没有价值。终止词不能用于检索。在 RefViz 安装目录下有一个 stopwords 的文件夹，

其中有个文件 default.stop.txt 是设置终止词的默认文件。可以修改终止词文件，首先将

default.stop.txt 保存在安全处，打开文件，进行编辑，删除一行可以除去当前行的终止词，

如果想增加终止词，增加一行，并写上该终止词。注意一行一词。输入完毕按保存即可。 

2.主词提取 

通过计算不同词的权重，确定主词和辅词。主词是 RefViz 认为区别文献的重要概念，

辅词与主词相关联并进一步丰富主词信息，可以分辨同义词，或识别主词之间的相互关系；

其它的词尽管可以查询，但对文献间的区别没有贡献，分为其它词。主词仅由标题和摘要中

的词决定，如果是 RIS 文献，并且摘要中没有内容，软件会调用 Notes 中的内容。因此，其

它地方的词，如作者，不会出现在主词中。 

3. 创建文献组 

根据标准聚类分析方法，创建文献组，并创建组标题。 

4. 视图展示 

根据文献亲近关系，将文献根据亲近性排列在 Galaxy 视图中。下面将会将到 Galaxy 视

图和 Matrix 视图，在学习这两部分视图时要注意体会两者之间的联系。在一种视图下做出

的选择，另一种视图也会发生相应的变化。 
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二、Galaxy视图 

Galaxy 视图提供了一种交互式的界面，可以探究文献间的相关性。Galaxy 视图中的文

献根据相关性排列，所以视图为我们提供了一种快速了解文献间相互关系的手段。 

Galaxy 视图是根据文献标题和摘要作出的亲近关系图，如果两篇文献的关系越近，他

们在图上的分布也会越近。Galaxy 可以帮助我们洞察哪些领域被反复研究，哪些文献没有

相关性。  

一）、打开 Galaxy 视图 

通过下图标注的按钮可以在 galaxy 和 matrix 视图间切换。 

 

二）、Galaxy 视图中的信息 

Galaxy 是相似性视图，文献或文献组越相似在图中分布的位置越靠近。视图的布局仅

由分析结果决定，同一篇文献，与不同的文献在一起分析，结果会不同。通过对 Galaxy 视

图的形状、分布等整体布局分析，你可以快速了解文献的主体信息。 

Galaxy 视图中一篇文献在以一个独立的小点表示，文献组在 Galaxy 视图中用 表示，

图表的大小表示文献数的多少。在视图模式下，有时候部分文献会叠加在其它文献上方，因

此，实际的文献，往往比看起来的要多。选择一定的区域，通过窗口下方的状态栏，可以知

道有多少文献。 

在 Galaxy 视图中，可以根据 Galaxy 视图的密度和形状获取一些信息。如密集的地方表

示这里的文献比较多，研究的内容受关注的程度比较高，稀疏的区域表示关注较少。不均衡

的分布表示某些内容出现较频繁。 

Galaxy 视图的形状也可以帮助我们了解文献的信息。如果整体分布呈卵形，说明所有

文献中，有多个主题对文献分布有贡献。如果整体呈狭长形说明有两个主题占优势。边缘的

文献 表示这些文献和其它文献不同，主要是由于文献内容差别比较大，有时候可能是由于

信息不全造成的。 
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两组文献间空白区域表示尚没有文献包含两个主题，由于文献是按相似性排列，因此，

如果某篇文献分布在两组之间，说明这片文献和这两个组都有一定的关系。 

联合其它工具，使用 Galaxy 视图请参见 working with  RefViz 

 

三）、Galaxy™视图的操作 

选择文献和文献组  点击文献和文献组图标，即可选中。当选择某一篇文献时，相应的

文献组也会被选中，但同一文献组中的其它文献并不被选中。选择文献组时，该组中的所有

文献也会被选中。按住鼠标左键，画出一个区域，该区域中的文献会全部被选中。当选择一

部分文献后，可以通过按住 ctrl 键，添加其它需要选择的文献。通过 Edit－>Select all，或

Ctrl＋A 选中所有的文献。被选中的文献会在主界面的下方 reference view 窗口列出来。 

取消选择 点击 galaxy 视图空白区域，可以取消所有选择（edit－clear selections）。按下

Ctrl 键，点击已选的文献或文献组，即可取消选择。 

显示文献或文献组信息  鼠标在文献组图标上停留，就会跳出一个浮动窗口，提供文献

组编号，这组文献中共有多少篇文献，同时还会给出这组文献中的三个主词。如果鼠标是停

留在具体某一篇文献的上方，会给出这篇文章的标题以及这篇文章所属的文献组。被选中的

文献会在 reference viewer 中列出文献的信息，如果想查看某篇文献的详细信息，在 reference 
viewer 窗口双击这条记录即可打开一个新的窗口，显示该文献的详细信息。 

   

Galaxy 视图的基本操作 浏览某一区域，可以选中 图标，按下左键移动视图，也可

以直接按住鼠标的中间键来拖动；用 可以放大或缩小视图，也可以用按住右键进行放大

或缩小； 可以将选定的区域放大至全窗口； 将被放大或被移动的窗口恢复到初始状态，

当前被选中的文献仍被保留。 

利用 galaxy 视图挖掘信息  我们除了可以通过视图的本身获取信息外，还可以进一步

结合其它工具了解更多的信息。例如我们可以把感兴趣的部分文献进一步创建子视图，获取

更详细的相互关系图；或可以去掉边缘的文献再作分析，也可以通过检索的方式获取进一步

的信息；还可以直接阅读文献的详细信息。 

创建子视图 在 RefViz 的视图界面，选择相关的文献，点击 edit->create subset view，根

据提示输入子视图名，点击 OK 即可。 

反选除掉边缘文献 在视图窗口中，除去边远文献的方法有两种，直接选择感兴趣的所

有文献，或选择不感兴趣的文献，再反选 Edit-> invert selections，然后创建子视图，新建的

子视图即除掉了那些边缘的文献。 
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直接检索 选中一组或一个区域的文献，通过 topics 窗口查看主词的分布及排列顺序，

可以了解所选文献中的主体内容。也可以用 search tool 找出某些（篇）已知重要的文献，该

文献所在组的其它文献，可能也和你所关注的主题相关。通过检索关键词，察看包含该关键

词的文献在整个视图中的分布，也可以获得一些有价值的信息。 

直接阅读文献信息  在 reference viewer 窗口阅读文献的基本信息，或者双击打开阅读

文献的详细信息。 

 

四）、Galaxy 视图的个性化设置 

选择 Edit -> Preferences…在子窗口中点击 Galaxy 即可设置 Galaxy 视图的颜色。具体设

置方式请参考前一章有关内容。 
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三、Matrix视图 

Matrix 视图显示的是文献组与主词或主词与主词之间的相互关系。在 matrix 视图中，

列总是代表主词，而行既可以代表文献组也可以代表主词。 

在 Matrix 视图中可以快速了解到主词在不同组中被讨论的情况，你可以快速发现哪些

概念通常在一起讨论，哪些概念之间有相似性等。 

当行代表文献组时（默认设置），Matrix 视图提供的信息是每个概念会在哪些组中被讨

论。在下图中，点选第 4 组，可以看到第四组的三个主词 aptamer，bind，rna 被高亮显示，

同时在列的方向上，除 map 一个主词外，其它所有的词也被高亮显示。这表明除了 map 外，

该视图中的所有主词都在第 4 组文献中出现过至少一次。 

 

你可以选择用颜色代表相关性，也可以用颜色代表文献的数量。默认设置用颜色代表相

关性，即主词与每组所有文献之间或主词与主词之间相关联的程度。红色表示关联性强，蓝

色表示没有关联。如果用颜色表示数量，则白色表示零，黑色表示最大。白色表示没有相关

性，黑色表示强相关性。 

在 Matrix 视图中，当鼠标停留在某个方格上方式，浮动窗口会显示出 Group 信息、Major 
Topic、相关性以及文献数量。如下图中，在当前文献数据库中 Library 和 Group6 的相关性

为 0.46667，共有 30 篇文献。 

Matrix 视图的排序 

不管每行代表的是文献组还是主词信息，都可以按字母进行排序或者按照相似性进行排

序。按字母排序可以很快帮你找到特定的主词，按相似性排列，你会发现很多概念上相关的

词会排列在一起。 
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Matrix 视图的操作 

在 Matrix 视图中，点击每个方格可以将其中的文献选中，此时 Galaxy 视图，topic tool
以及 reference viewer 窗口都会同时更新。如果鼠标停留在一个方格的上方，浮动窗口会显

示出该方格中的信息，包括每行代表的文献组信息或主词信息，列代表的主词信息，相关性，

文献数量等，如下图： 

   

在 RefViz 中所有选中的文献都会在 referecence viewer 窗口显示，并且 topic tool 窗口信

息也会及时更新。 

选择一个或多个方格的方法很简单，直接点击可以选择一个方格，按下 ctrl 键再点击其

它方格，会将这些方格都选上；也可以按下鼠标左键画出所要选择的范围，其中所有的方格

都会被选中。如果行代表文献组，点击行的标题，可以选中这一行所有文献。点击主词，不

管行代表的是文献组还是主词，会将所有包含该主词的文献选中。相当于在 search tool 中在

title 和 abstract 中检索该词。 

取消所有选择 Edit-clear selection, 或者 delete。matrix 视图中的放大、缩小和移动与

galaxy 视图中相同。 

利用指示窗浏览 Matrix 视图 

如果 matrix 视图的内容在主窗口显示不下，主窗口将只显示一部分，同时在右上角的

位置会显示出全景图，图上会出现一个指示窗，表示当前主窗口显示的内容在全景图中的位

置。可以按住左键进行移动。利用快捷键，鼠标中间键和右键操作时，指示窗也会发生相应

的移动。 

在 Matrix 视图主窗口的下方，由三个选择框，分别可以设置颜色代表相关性还是文献

数量，按字母排序还是按相似性排序，以及行代表文献组或是代表主词。 
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判断行列主题间的相关性 

如果你点击主词，不管是在行还是列方向，所有包含该主词的文献都会被选中。你可以

看到其它很多主词也会被选中（高亮显示），表明这些词也在这些文献中被讨论到。 

如果行代表文献组，包含该主词的文献组也会被选中，这提供了一种快速了解哪些组包

含某个主词的途径。该功能可以通过 search tool 工具实现，但利用 matrix 视图更为便捷。与

topic tool 对应，topic tool 可以快速显示文献组中的所有主词。 

通过方格的颜色可以知道文献间的相关性。如果两个主词之间的相关性较大，表示这两

个词可能存在某种特殊的联系。 
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四、主词工具（topic tool） 

通过 topic tool 你可以快速了解到文献的大致研究内容。同时，topic tool 也提供了一种

有效而简单的方法去影响分类，通过调整 topic tool 列表中不同词汇的权重即可实现。 

Topic tool 窗口共有三栏，分别是 major topic（主词），minor topic（辅词），和 descriptive 
terms（描述词）。其中主词和辅词来源于标题和摘要（或 notes），descriptive terms 包含除主

词辅词以及 stopwords（终止词）外的词汇，以及分布在除标题和摘要以外的信息也会出现

在这里。所有栏位的词除了 stopwords 外都可以进行检索。 

Topic tool 中的词汇列表会随着所选文献的不同而及时更新。点击各栏位上方的标题即

可通过字母或出现的次数进行排序。 

在 topic tool 中的词汇会有三种颜色显示，其中大部分为黑色，蓝色部分为程序为提高

处理速度预设的 others word，这些词会自动出现在 descriptive terms 栏，红色的词汇表示经

过提升或降级的词汇。 

选择所有的文献，通过 major topics 可以了解文献的主旨。有些情况下，如果文献比较

少，可能会没有辅词。通过选择不同的文献组，在观察每个文献组的主词，可以大致了解到

这些文献间的差别。也可以选择不同的区域，来通过比较不同区域的主词，来了解不同区域

的主要内容。还可以通过增加选中的文献，并注意主词列表更新的情况，了解文献的内容。

在 Galaxy 窗口，每组浮动窗口显示的三个词就是该组中出现频率最高的三个主词。有些文

献组的主词会有重叠，表明这些重叠的词在某个领域中占有重要的地位。比较详细的主词列

表，可以看出这些文献组之间的差别。 

 

通过主词影响文献分类 

选中所有的文献，浏览主词和辅词列表，根据你的专业知识和你想了解的内容，你可能

会发现有些词列在辅词甚至 descriptive terms 中，但很重要，此时可以通过 promote 将这些

词提升为主词；如果主词中有些词对分类没有意义，可以通过 demote 降级为辅词甚至

descriptive terms。经过调整之后，topic tool 中的词汇列表将不会随着你选择的不同而及时变

化，而会出现红色字体显示的提示：“Topics frozen - changes pending. Reprocess or Reset.”。
选择主词可以通过鼠标单击词汇，也可以通过按下 ctrl 增加词汇，或用 shift 选中连续排列

的词汇。 

如果需要调整同义词并进行词汇权重调整，建议先进行同义词设置和更新。不管你是否

选中了所有文献，词汇权重的调整都是针对全部文献来执行的。所以对词汇权重调整时，建

议选中所有文献。 

词汇权重调整后，要进行 reprocess，也可以选择放弃 reset，恢复到调整前的状态。 

注意：有时候小的调整会对视图的分布产生较大的影响，但文献间的相互关系还会被保

留。即 Galaxy 可能看起来有较大差别，但原来分布在一组中的文献，基本还会在一起。点

击 reprocess 后，会出现如下窗口： 
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 　Create New View (default) 可以修改新建视图的名称 

 　Overwrite Existing View 将原视图删除 

 　Cancel 取消创建新的视图 
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五、搜索工具（search tool）  

Search tool 的作用不是一个简单的查找工具，它更重要的应用应该是利用 search tool，
结合 Galaxy 视图等发现文献间的相互关系。Search tool 提供多种检索方案，可以在指定栏

位检索，可以检索特定日期，或者使用逻辑关系式进行检索。 

通过主界面右上角的按钮可以在 topic tool 和 search tool 间切换，  

 

检索界面如下： 

 

在执行检索时，在 Galaxy 界面，RefViz 会将检索到的文献高亮显示出来，同时，所有

被检索到的文献也会在主界面下方的文献预览窗口列表显示，在 topic tool 中的词汇列表也

会随着所检索到文献的不同而及时更新。Matrix 视图中选定的文献也会同步更新。因此，可

以通过检索工具，结合视图、可以发现特定文献与其它文献间的关系。如果检索的是年代，

可以发现每年发表的文献在所有文献中的分布。结合 reference viewer 和 topic tool 可以发现

 

如何进行检索   

，输入完毕点击

Search  

，

如果检索的是短语，只要同义词列表中定义了相应的同义词，检索时会一并予以显示。

被检索到的文献的主要内容主旨。

 

在检索窗口 field 栏位选择要检索的位置，在 parameter 栏位输入检索词

即可完成检索。如果是多个检索词，可以选择相互间的逻辑关系。

All Text Fields 多数情况下是指除日期之外的所有栏位。Stopwords 通常不能检索，如果

需要检索需要使用双引号。检索对字母大小写敏感。检索结果同时会反馈出检索词的同义词
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由于 RefViz 进行分类是依据标题和摘要，所以如果你的检索限定在标题或摘要位置，

得到的检索结果与

索词，RefViz 会默认为相互间用 AND 连接。在检索界面的

query

如果单纯输入数字，会显示如下提示窗口，数字会自动以词组形式被处理。 

topic tool 等具有一定的对应关系。 

如果在同一栏位输入多个检

窗口会显示逻辑表达式。 

 

 

果检索  

如果检索词中包含拉丁字符或其它特殊字符，需要用双引号将检索词标注出来。 

特定年代，也可以进行跨年代检索。如果只检索特定的年

代，可以输在任何一个方框中。 

合检索时，检索式必须连续输入，如果在检索式中间空一行，空行后的检索式

将被忽略。 

在 RefViz 中可以使用指代符，“？”可以在检索词中任何一个位置代替一个字符，*可
以表示多个字符。例如检索 st?ck，将会找到包含 stack, stick, stock, 和 stuck 的所有词汇；如

strateg*将会找到 strategy, strategic, and strategies，如果定义了同义词也会一并找出。

在 pub date 检索栏，可以检索

在进行组

 

查找到的信息可以进一步察看文献的完整信息。显示详细文献信息窗口有两种方法，一

是通过 Tools -> Show Reference Viewer Preview Pane 进行选择，二是在预览窗口双击某一篇

文献。 

在文献详细信息窗口，可以看到被检索的词会以高亮的形式被显示出来。其中绿色的是
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remedy 的
同义词 remedies。这个功能可以帮助我们在文献中快速定位到想要找的信息。 

输入的检索词，褐色的是输入检索词的同义词，如下图中，检索的是 “herbal AND remedy.”，
如图中 herbal 和 remedy 显示为绿色，而它们的同义词显示为褐色，下图中有一个

 

快速检索

ck search 检索之后，双击打开文献信息窗口，可以看到检索词及其同义词会被

高亮显示。 

Quick search 

Quick search 中不能制定在特定的栏位检索。如果输入 1900-2040 之间的数字，RefViz
会默认在 pub date 栏位检索。如果输入多个关键词，RefViz 默认为以 AND 连接，在 quick 
search中不能进行NOT或OR等复杂检索。Quick search 可以用于快速定位文献中的关键词，

如，利用 qui
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六、同义词 

同义词在 RefViz 进行分类时会进行等同处理。同义词主要指词的单复数、词的不同词

性形式、全称和缩写、同一词的不同拼写形式等。 

添加同义词是影响 RefViz 进行分类的一种非常有效的途径。在主界面的快捷工具栏中

有一个 Thesaurus 快捷按钮，在状态栏还有一个按钮（view thesaurus current）,点击可以浏览

当前文件中的同义词。 

 

 

如果对同义词列表进行过修改，而 RefViz 没有重新进行过分析处理的话，状态栏中的

同义词图标就会显示为红色 ，如果以进行过处理或者视图生成后未进行同义词调整，则

显示为绿色 。 

通过点击快捷键或者 tool-thesaurus 进入同义词列表，如下图所示： 
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刚进入 Thesaurus Tool 界面，除 close 和 help 外，其它所有按钮均为灰色。在 term 栏位

输入想添加或查找的单词，点击 Look-up/Create 按钮，可以在已建的同义词库中查找，如果

已有相应的同义词，在 synonyms 处会显示出来；如果没有相应的同义词，可以在此处输入，

然后点击 Add Synonyms 创建。可以通过 Make Headword 将其中的核心词定义为头词，即在

同义词列表中这个词处于最前面。如果进行了同义词修改，界面左下角的图标也由绿色转变

为红色。 

如果只输入一个单词而未输入同义词，是不能创建同义词列表的。但如果输入的是词组，

则可以创建，其目的是让 RefViz 能够识别词组，在进行文献分类时将词组作为一个整体进

行处理。同义词进行调整之后可以进行 reprocess，重新进行文献分类分析。 

终止词和其它词汇 

Stopwords 即终止词，类似 also who very 等词汇，对分类没有帮助，这些词被定义为终

止词，以加快 RefViz 处理文献信息的速度。所有被定义为终止词的词，不能直接检索，如

果确实需要检索这些词，可以用双引号标识，按照词组的形式来进行检测。 

终止词可以进行设定，在 RefViz 安装目录下，有个 stopwords folder 其中有个文件为 
default.stop.txt，其中即为所有预设的终止词。如果需要修改，建议先将这个文件拷贝到其它

位置做一安全备份，然后再进行修改。文件中一个终止词占据一行，修改时必须也遵守这种

格式。 

其它词汇（others terms）并不参与文献分类，将一部分词预设为 others terms，其目的

同样是为了加快文献的处理速度。others terms 可以根据需要进行修改，在 RefViz 安装目录

下有个文件夹 minorterms folder，其中的文件 default.minor.txt 即为软件预设的 others terms，
修改时请务必先保留一个备份。同样每个 term 单列一行。 
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七、输出文献到文献管理软件 

当你通过 RefViz 找出你所感兴趣的文献之后，你可以将这些文献输出到文献管理软件

中。可以通过 Galaxy 视图、Matrix 视图、主界面的文献预览窗口、或者 search tool 选择感

兴趣的文献，通过 file 菜单下的 Send References to－>Bibliography Manager 或者快捷工具条

上的 将文献输出到文献管理软件。文献会自动输出到在 Preferences Helper Application

设置的文献管理软件中。RefViz 已经预设了 Endnote、Reference Manager 和 Procite 三款文

献管理软件，如果软件不是安装在默认位置，需要进行设置。设置窗口在 Edit－>Preferences-> 
Helper Application 下。 

文献自动输出到文献管理软件，并提示你打开一个已经存在的数据库。如果要将文献输

出到一个新的文件中，需要在文献管理软件中事先创建相应的文件。 

 146



文献管理与文献信息分析 罗昭锋 韩敏义等编著     版本 1.00 

八、文献信息分析 

这一部分主要以举例的方式，介绍如何完成常见的分析任务。 

 

1、如何知道我检索到的文献是不是关于自己想要的主题？ 

  1）执行检索，如果利用 RefViz 的检索工具直接联网检索，RefViz 软件将会自动对检索

到的信息进行分类处理，并创建视图； 

  2) 查看视图，分析文献被如何分组，通过 topic tool 可以调整主词及辅词的权重，从而

使视图能够反映你的特殊需求。将鼠标停留在文献组上方，阅读浮动窗口的信息，或者选

中文献组，通过 topic tool 中的信息来了解文献组的大致内容；通过 topic tool 中的主词及

辅词列表可以了解到哪些词影响文献的分类；也可以通过 reference viewer 了解具体文献

的信息； 

  3）判断是否所有的文献都是你所感兴趣的，如果不是，需要精炼检索； 

  4）在 Galaxy 视图上是否有一些处于视图边远位置的文献？如果有，这些可能与主题不

相关。阅读文献的标题判断是否相关，如果不相关可以选中其它的文献，创建子视图。file
－>create subset view。 

 

2 如何利用 RefViz 精炼宽泛的检索？ 

 1)执行检索，创建视图； 

 2)通过 Galaxy 视图查看文献分布，选中所有的文献，查看 topic tool 了解文献的大致内容，

如果需要可以通过 demote 和 promote 改变主词辅词的权重，对文献视图进行调整，查看

单篇文献或文献组； 

 3)如果找到你感兴趣的文献，选中该文献组或临近区域， 可以 create a subset view; 

 4)找到相关的文献后，可以将他们输出到文献管理软件； 

 

3 如何将不同数据库检索的结果联合起来？ 

  在 RefViz 中可以同时检索几个数据库，并自动删除重复，创建视图。如果检索结果

分别保存在几个文件中，可以通过 Creating a View using Reference Files 创建几个文件的综

合视图。如果这几个文件在一个文件夹下，可以一起选中；如果这几个文件分布在不同的

文件夹，可以通过 Add 将不同的文件链接起来创建视图。需要说明的是，不同文件中的

重复文献在 RefViz 中将被保留。 

 

4 如果检索到的文献结果超过 1000 甚至 10000，如何确保不会扔掉重要的文献？ 

 1)执行检索并创建视图； 

 2)利用 RefViz 浏览视图，查看相关的信息分布； 
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 3)利用 search tool 检索关键词，查看文献的分布,哪些与你找到的文献在分布上比较靠近，

却没有被选中的文献，可能就是相关但容易被漏掉的文献。 

 

5 如何快速了解一个领域？ 

1) 执行检索，创建视图； 

2) 通过浮动窗口了解每个文献组的信息；也可以点击每个文献组，分别查看 topic tool 中
列出的主词和辅词；可以根据需要来调整主词和辅词的权重，使分类符合特殊要求； 

3)查看 Galaxy 视图，连贯均匀的分布表示每个主词重要性都差不多，如果某个地方文献

分布比较集中，说明这里是过去研究的重点方向。 

 

6 如何深入了解某个主题的信息？ 

1) 检索并创建视图； 

2) 搜索感兴趣的特定主题，仔细分析文献在整体文献中的分布； 

3) 从 matrix 视图查看哪些主词和某个文献组相关联，这将帮助你理解这些文献为何被放

在一组； 

4) 利用 matrix 视图，查看主词与主词之间的关系，这可以帮助你通过熟悉的概念找到不

熟悉却又相关的概念； 

5) 当你发现某个文献组的信息比较重要，可以利用 reference viewer 查看该组的文献；你

可以通过出版年代、作者以及出版社判断哪些文献应该详细阅读。 

 

7 如何快速发现某个作者在哪个领域工作？ 

 1) 执行较宽泛的检索，并创建视图； 

 2) 查看 Galaxy 视图理解每组文献的重点研究内容；可以通过影响词的权重而影响分类； 

 3) 选择感兴趣的文献组或一个区域，在 reference viewer 预览窗口利用作者排序，看到某

个作者的文献排列在一起。（注，RefViz 说明书中提供的这套方案，不如用 search tool，
直接检索某个作者，查看这个作者的发表的论文在整个文献中的分布。） 

 4) 对于特殊的领域，可以通过 search tool 发现相关的文献。 

 

8 如何得到我感兴趣文献的详细信息？ 

1) 检索并创建视图； 

2) 通过 search tool 发现并选择感兴趣的文献，通过 file－>Create subset view 创建子视图，

新创建的子视图完全基于感兴趣的文献，可以提供更详细的信息。 
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9 如何发现哪些主词与特定的主词相关？ 

 1) 在 matrix 视图，选择特定的主词，其它同时被高亮显示的主词表示会和当前主词在相

同文献中被提到； 

 2) 如果用相似性排列图表，分布比较靠近的主词将是同时出现几率较高的词汇。这种方

式可以帮你找出相关的关键词。 

 

10 如何查看两个主题是否相关？ 

 1) 在 matrix 视图，将行列均设为 major topic，按字母排序，找到两个主词的交汇点，将

鼠标停留在该方格上方，会显示出该方格中包含的文献数量，相关性等。这种方法仅适用

于查看的两个主题词都是主词的情况。 

 2) 另一种方案是在 Galaxy 视图界面，用 search tool 检索两个主题词，看文献在视图中

的分布情况； 

 3) 另外，分别记下单独查找两个词时的文献数，再用 OR 同时检索两个主题词，看三个

文献数之间的关系也可以看出相关性。 

 

11 分析某一主题的发展趋势？ 

1) 查找文献并创建视图； 

2) 用 search tool 查找每年的文献，然后观察 topic tool 中主词和辅词的分布及变化；可能

会发现某些词在特定年份占优势；并注意每年文献在 Galaxy 视图中的分布，根据文献分

布的不同可以知道发展的趋势。 

 

12 如何发现哪些主题渗透到自己的研究领域？ 

1) 检索并创建视图，如有必要进行精炼检索； 

2) 查找最近的文献，查看 topic tool 中的主词、辅词以及描述词列表，查看哪些像是新出

现的词汇。然后利用 search tool 检索，确认这些词是不是最近才出现。注意此时不能只查

看主词和辅词，因为很多词刚出现时还不会影响分类。 

3) 并不只是最近使用的词才是新渗透进来的，有些词尽管已经使用了很久，但两个词组

合使用才是最近出现的，也可能是新渗透进来的概念。我们可以在 matrix 视图查看两个

词的交汇点，查看其中的文献是否为最近的文献，如果是，再通过检索进一步确认。 

 

13 如何确认在论文的介绍部分和论文的讨论部分该引用哪些文献？ 

1) 在撰写一篇论文或者一份申请时，你会希望引用所有相关的背景文献。一种有效的方

案就是，先用较为宽泛的条件进行检索，然后利用 RefViz 创建视图； 

2) 可以通过前面的方法，获得一个概要的了解，也可以通过创建子视图，进一步深入了
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解相关的文献；与主题最接近的文献组中的文献可能都是相关的。 

 

14 如何找出与某篇已知文献最相关的文献？ 

1) 有时候你可能知道某篇文章和你的主题非常相关，但还想知道有没有其它的文献支持

同样的观点； 

2) 查找相关的文献并创建视图，利用 search tool 找出已知的那篇文献，分布在这篇文献

同一组的文献以及临近的文献可能都是相关的。 
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第十四章 Quosa软件简介 

Quosa 软件是一款优秀的文献信息处理软件，它的文献全文自动下载功能、最新进展追

踪功能、pdf 文献信息自动识别功能以及全文分析功能是其它文献管理软件所不具备的。本

人接触这个软件的时间较短，也不大熟悉，但鉴于它强大的功能以及广泛的实用性，这里作

一下介绍，希望起到抛砖引玉的作用。 

这款软件也有它的局限性，目前该软件可用的数据库来源比较有限，在软件主界面菜单

中的 channels 下可以看到所有可以直接检索的数据库，主要局限在生命科学领域，但它的其

它一些功能的应用并不受此局限。本章主要介绍以下内容： 

1. 软件的安装及主界面简介 

2. 文献检索及全文下载 

3. 文献追踪 

4. Pdf 文献信息识别 

5. 文献信息分析  

6. 输出文献到文献管理软件 

一、软件的安装及主界面简介 

在quosa公司的网站上提供试用版下载，也可以直接向公司购买完全版软件。公司网址

是http://www.quosa.com。quosa软件包括quosa information manager和quosa virtual library，目

前只有第一个软件提供试用版。下载软件直接点击即可安装。 填上姓名&email就可以获得

code，然后就可以有 20 次的免费试用。 

运行程序，主界面如下：窗口 1 是文件的管理窗口；2 是程序的检索窗口，默认设置打

开程序自动连接到 PubMed 网站；3 是程序的快捷键按钮；4 是文献分析处理栏。 
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二、文献检索及全文下载 

文献检索是使用 quosa 的第一步。打开软件会自动连接到 PubMed 网站，也可以通过

channels 菜单来修改检索的目标数据库。在上图中我们可以看到检索界面和直接通过网络浏

览器登陆到 PubMed 完全一样，所以检索方式也完全一样。 

当检索结果显示出来以后，可以通过 2 号窗口中的选择框选择下载全文、网页文件还是

只下载摘要。在第一个方框中输入一个数字，表示下载文献信息的数量，设置完毕点击下面

方框中的 Retrieve 按钮。即可开始将需要的文献信息下载到本地计算机。 

 

下载到本地的文件，软件会自动建立文件夹，如下图所示，文件夹自动以检索词作为名

称，同时会显示其中的文献数量。也可以另外创建文件夹，放在 my folder 下，文献数同样

会显示在名称的前面。 

 

点击相应的文件夹，在程序的主窗口会显示详细的信息，如下图： 
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上图中 1 是显示窗口设置，results 指只显示检索结果；browser 只显示文献信息浏览窗

口，即 PubMed 界面部分；both 两部分均显示，上图为 both 模式，上方显示的是检索结果，

下方是浏览窗口。可以在预览窗口位置直接打开 pdf 文件。 

在进行文献检索时，建议一开始可以只下载摘要信息，在对文献的摘要信息经过分析之

后，可以选择性下载有价值论文的全文，如下图： 

 

检索到的文献软件会自动保存在 my searches 下面，建议当你的检索完成后，将资料移

到其它文件夹，这样会比较安全。如果文件保存在 my searches 下，重新执行检索时，前面

检索到的东西容易被覆盖而导致信息丢失。 
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三、检索Google Scholar 

从 Channels 下面选择 Google Scholar，进入如下检索界面，输入检索词，检索结果出来

后，在 Retrieve 方框中输入下载文献的数目，点击 Retrieve 即可将检索结果下载到本地计算

机中。 

 

下载后的结果如下图： 

 

 

也可以通过浏览器上 Quosa 快捷菜单，将检索全文加入到 Quosa 中。首先通过 Google
检索到相应的全文并在窗口中打开，点击浏览器窗口中的 Quosa 快捷键，选择 Add to 
QUOSA，即可将当前文献输入到 Quosa 软件中。 
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四、文献追踪 

很多科学工作者一直在追踪最新文献，了解科学前沿。如果通过每天到不同数据库检索，

无疑会耗费大量的时间。Quosa 提供自动追踪最新文献功能，可以按照设定的周期定期到网

上检索相关的文献，如果有新的文献出现，会自动下载到本地计算机上或者通过 email 来通

知你，省去你重复到网上检索的时间。 

在左边的窗口 My Article Organizer 点击 My Searches，然后点击已经完成的具体检索项

目，再点击结果栏快捷键中的 Set Alert。如下图所示，会进入到 configure search alert 界面，

在这个界面可以设置检索的周期，每天检索的时间，通知的方式，文件保存位置等。同时我

们可以看到在这个界面，search 的项目“intein”就是我们当前打开数据库的检索词。 
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进入 set alert 也可以通过菜单进入： 

 

注意在 configure search alert 界面无法设置检索内容的，只能通过事先选择特定检索条

件来确定。 

 

五、Pdf文献信息识别 

Quosa 能够从 pdf 文件中将文献的 title，author，journal，volume，page 等信息识别出来，

这是其它软件所不具备的功能。在推广 Endnote 的过程中，经常被问到“我有很多 pdf 文献，

怎么通过 Endnote 进行管理？”这样的问题。在接触 quosa 之前一直没有一个自动化的方法，

只能通过手工方法一个一个导入到 Endnote 中。 

Quosa 的 import pdf library 可以自动将一个文件夹中的所有 pdf 进行识别。从下图中的

两个位置可以进入文献信息导入界面。 
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点击 import pdf library，进入设置界面： 

 

信息识别需要花费较长的时间，需要耐心等待，如果需要转换的文件较多，建议在计算

机闲时进行。上述图中，quosa folder 必须进行设置。点击 import 之后，可以看到软件处理

的进程窗口，处理完毕，软件会提示所有文献已导入的提示。可以通过本章下面的方法将文

献输出到 Endnote，再将相关的全文插入到相应的文献记录中。 

根据个人经验判断，quosa 识别 pdf 文献中的信息依赖于网络。同样的文献联网和断开

网络两种情况下，识别的情况相去甚远。 

如果你有很多 pdf 全文，希望通过 Endnote 进行管理，建议参考 Endnote 常见问题解答

部分。 
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六、文献信息分析  

Quosa 的全文信息分析功能是 RefViz 的一个重要补充，RefViz 只能对标题和摘要进行

分析，分析的文件仅限于文献数据库文件或具有一定格式的文本文件。 

主界面右上角视图快捷键窗口，  

 

点击 To Advanced View，会进入高级模式，此时左下角会出现信息分析快捷方式。 

 

选定文献数据库，点击 concepts4clustering，可以对当前数据库进行分析，依次会出现

如下信息处理窗口： 

STEP：1 of 4 – Calculation relationships 

STEP：2 of 4 – Processing 

STEP：3 of 4 – Clustering 

STEP：4 of 4 – grouping terms 
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处理完毕显示的结果如下图，窗口的左边会显示出软件找到的所有关键词，关键词的左

边是包含此关键词文献的数量，点击关键词前面的+号，会进一步打开该关键词的一些近义

词或衍生的关键词。单击关键词会在软件的右上窗口中打开包含这个关键词的文献列表，右

下的窗口可以浏览某一篇具体文献的信息。 

 

在下图中，可以在左边的 concepts4clustering 中红色方框中看到关于 ce selex 的文献共

有 6 篇，在右边文献信息窗口中 In Cluster 下，有六篇文献带有 表示，表示这些文献是和

当前选定的关键词有关。 

 

根据软件找到的关键词（这些关键词并非文章中列出的关键词，而是软件经过分析得出
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），我们可以快速了解到特定的信息。 

在与文献管理软件联用之前， 从 main menu

设置完毕可以将文献输出到文献管理软件。首先在文献窗口选择你感兴趣的文献，点击 To 

的

 

七、输出文献到文献管理软件 

你需要通过软件设置你所使用的文献管理软件。

下的 settings，点击 citation manager, 点击 select citation manager，设置你的文献管理软件。 

citations 快捷按钮。 ，软件会自动调用文献管

理软件，并提示你将文献输入到哪个已存在的数据库文件中。如果想输入到一个新的文件中，

需要你事先在文献管理软件中创建该文件。以上输出功能也可以通过 toFile-export-  endnote 
fman  etc 完成。Quosa 软件也可以将 Endnote 等软件的数据库导入进行分析。 re

 

关于Quosa的更多功能，请读者在掌握这些基本功能之后进一步学习摸索。Quosa的帮助可

以参考www.quosa.com公司网站上的内容，也可以通过

将摸索出来的经验和大家分享，欢迎你将你的

help中how do I…来查看。真诚希望你

学习心得发布到我们的论坛，

ttp://biotech.ustc.edu.cn/forumh   文献管理版块。 

 

 

http://www.quosa.com/
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